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m  CY3217-MiniProgl 4228 &8 CY8CKIT-002 Miniprog3
m  USB A # Mini B 245

3 Windows XP B SR AR PC

1.3.2 fiFE

K 1-1 #oR 7R E TR, AiZE D, it —4 22x2_RA_Receptacle ¥ CY3280-20x66UCC Ef£H CY3280-
SLM fibiEisisk. MRJE, 4 MiniProgl/MiniProg3 B¢ 12USB #i##/MiniProg3 ¥ e 1RSI EM 1) 1ISSP i E.
ZWE M MiniProgl/MiniProg3 #E4T4w e, IFEH 12USB #i4%2%/Miniprog3 K 5i#i k%4 PC. &Ja, it USB £
S EiERER PC k.
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Pl 1-1. B s EAE

—»[ MiniProg1/MiniProg3 ]—

CY3280SLM H CY3280-20x66 UCC ]—

—{ I2USB / MiniProg3 ]—

1.3.3 AL AR
BT LR OB b

# CY3280-SLM T i fE J1 5] CY3280-20x66 UCC HLEEHR L[] 22x2_ RA_Receptacle GEE#S P2) L.

e J7 LB — AN BEERSRS, K UCC FLESHR MG Vee M1 Vee proc JE¥E. ZBE U EIEIT ISSP E#8 4%
CapSense il #5LH.

EFERE JA4 LCE — N Bkekss, K UCC HLERIFSI I XRES Al XRES/INT (51 1 1 2) H#. ZRKESH
CapSense =il #% 1) XRES 5| HIE#: S ISSP 4% I3 151 3.

TERREE 32 L8 — AN B2k 2%, K CY3280-SLM HLEEAR A 5|l GND FI SHIELD (5|l 2 i 3) 4E4z. BiliZdHE,
T CY3280-SLM HEEE R B WA A% B2t

# MiniProgl/MiniProg3 H##:E] UCC HUEEHR Y ISSP i 33 o A4 A 7S HEfI SO = A AR Sk 48 UCC
W, 7 B ZEE:. @il Bridge Control Panel #4i:Hl CapSense ##Ei, FTFEFH 12USB #rE:4%/MiniProg3
8% MiniProgl/MiniProg3 #1744

i F§ USB A % Mini B 4% MiniProgl (E{ 12USB #i#%#%/MiniProg3) 1% —iti%E#: 2 PC L.
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1.4 FEE

CapSense®z il a3+ Cid 7~ 1

CapSense Buttons Slider
Gmod Pi[6] 560 11 PR1[4] sLDO
2.2nF =
cap_buto PRO[8] sLD1
. 2 5V PRO[4] SLDZ
gl = |8 P1]3] 560 12 ; t ;t
PRO[2 SLD3
cap_butt PR2[6 sLDd
U1 “‘I 4 P3[3] 560, 13 PR2[4] SLDS
T 0o m B E Q Q 0
S o 2258 2 2 a8 cap_but2 PR2[2 SLD6
1 o o oo = R7 560  PR2[B =
NG PR2[0] j§ ;§ SLD7
P2[7 R6 560 PR2[4’ P2[1 560, 14
P2[7] paj4) |8 — PR3[2] Q ;Q SLD8
L2 3 fpg P[] | a4 RS A A 560 PR2[Z] cap_but3 — .
P2[3 4 R4 560 PR2[0
P213) P2[0] P2[3] 560 15
Peli] 5 a2
! P21] Paf2)
cap_butd
PaR] CY8C20666 416
— papi) afe) [F—
—E Pap7) Paj4) F2— LEDs sv
R3 560 PR3[2 T
—2{ pgy5) Pa[2] LEDO
P3[3 papa] pajo] |22 R2 560 PR3[0] P2[5] haat 16
—u] |26 K
Pa[1] XRES LEDA
T _PiE P16 Pa[7] W 17
@ m = 0 o & & =
= 0o o = 5 @ + . O - = = 1K
PO[1 Y 18
o 1K
2 LED3
PO[5 = 19
- 1K
= i LED4
Pi[2 s 20

BRI 2.2 nF KIS EZE (Cvop) #EH:F] PO[3]5I I L. fHH— 560 Q KHLFHK %> CapSense 124 Hf B K,
DL 40 % LED BLB AMREEAR, 4TS5 1kQ MR EBBGER. ZRMEhIA A LED. T

M= 10 A AT BRI 5 .
% 1-1. LED. %SRBI 5I H7r i

PR1[4]

LED EreL:d WHRE
LEDO - P2[5] | BTNO-P1[6] | SLDO - P1[4]. SLD1 - PO[6]
LED1-P2[7] | BTN1-P1[3] | SLD2-PO[4]. SLD3 - P0[2]
LED2 - PO[1] | BTN2-P3[3] | SLD4-P2[6]. SLD5 - P2[4]
LED3 - PO[5] | BTN3-P2[1] | SLD6-P2[2]. SLD7 - P2[0]
LED4 - P1[2] | BTN4-P2[3] | SLD8-P3[2]. SLD9 - P3[0]

1.5 HHRE

151 FrilTH
®  PSoC Designer™ (A< 5.2 B8 &l A)

®  PSoC Programmer (JRAS 3.13 B3 SfRA)
m  Bridge Control Panel 1T E

1.5.2 H P HEHF|F=
T HRFUH T AR G R PR (UMD LA A UM 37 5 F BB 2 95

WWW.Cypress.com

AYYRS: 001-85848 iR AS*A
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R PR

TEAFBIR

SmartSense

CapSense fiILL# 8. e 4 1

EzI2C

I2C/SPI ik

1.5.3 HPBIRSHL. &R TR
51 F 1) ReadMe. txt SCH-R T 2 ARF7= BIBT 4 FiL S HERIO S RO I b, SEHR4E T — 2R BIgIER

1.6 #HAEHH

LIS, [ AFRE AT AR e

i) CapSense T8 IR

fEfe 4 m i, #RJ5)53) SmartSense f F bk,
B EzI2C UM, ARG LK Myl2C_Regs # & N 12C RAM Z21(X .

TEBRAEIA AT T T A -

CapSense®z il a3+ Cid 7~ 1

SEX—AEHIE Myl2C_Regs UMF i8S 5 JRAATHEL, THECEME . JREL. O i B DLRZ R 5 Bt B

o FRELERATA RS, RN MyI2C_Regs @R HT R TIEL. T EEE . B, WA OB REE

ense FEIPIRE . 12C R WA BT K Hck g 5 5 N\ F EzI2C N4 12C ZZrh X s — 70, fRkiER
TR F B CapSense 3

o YRR B A R A, AR ANA LED RSN “ON” (FTHF) o BEididgnt, LED KIPIRESH
Py “OFF” (KD

CapS

o B, 2R LED MRREDION “ON” (3T, DUR i fil i hr & .
K 1-2. ARl 1 KZhRgniRE

Start

4

Enable global
interrupts

v

Set I°C RAM buffer

4

Start I°C

Start SmartSense UM

4

baselines

Initialize CapSense

Loop forever

Scan all sensors
Update all baselines

v

Check for active
sensors

A

Update LEDs

;

WWW.Cypress.com

Update I°C RAM buffer with

CapSense parameters

(RawCount, Baseline, SensorMask,
Difference Counts Slider Position)

AR5 001-85848 iR AS*A
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1.7 PATARIGRBI

I H R AL FEER AR, SRS IR AT A R Bl . BRI fE UCC RIS PEAME S, 162 L CY3280-
20x66 B P K 5 T

1. f#H MiniProgl/MiniProg3 5 CY3280-20x66 UCC E /57 HET /- H AL R — AN X BRI 5 V IR

2. fih¥ CY3280-SLM HRELHL AR b2 Eig 2% . CY3280-SLM HEE M AR M Y LED 43 5558
3. fulEIEANREE, CY3280-SLM #EHE BRIk FAHRI LED 238 . AT DL RN il 22 AN 4ackl, o wT DR A A 2%
TV AR RN 42

1.8 it I1°C £ CapSense i

YR P HAT AR R,  FH Bridge Control Panel T.E _E ) CapSense #¥i#f. 4% Bridge Control Panel [{J5 £
VEE R, 520 AN2397 — “CapSense®HiEEE TH” .

1.8.1 Jn#% Bridge Control Panel T.H.
{8 12USB Hr#88/MiniProg3 1 USB A ¥ Mini B 4504 & 115415 CY3280-20x66 il CapSense 5l 2% B

1.
PRAR IV ISSP s I3 B4R

2. (K b, fRikiE$E Start > All Programs > Cypress > Bridge Control Panel (#Z#) > Bridge Control
Panel (JRA) .
Bridge Control Panel &% PSoC Programmer 2235 i 2 o 2238 ) — AN A o

3. MRS O R RIS HE AR

4. Y CY3280-20x66 CapSense 2 il #5 HL M IR L 5 V ( HLE

5. M Bridge Control Panel & Kk kit File > Open. N S R 4130 H S #F% BCP Configuration Files S 3%
FN#E BCP. iic .

WWW.Cypress.com TGS 001-85848 fRA*A
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N

o

BCP.ini Xff.

t_'"iBlidge Control Panel

File  Edtor Chart Execute Tooks  Help

SEE fnR oL BEEE

CapSense®z il a3+ Cid 7~ 1

W% $E Charts > Variable Settings. M AU R H 2432 1) BCP Configuration Files 4 3 v in

- [Bx)

Edtor | Chat | Table | Fle |

;IZC_Writa «5lave Address> <Offset> <Sensorindsx = Sensor#>
JSensor# = 00 for BIT#D

sGensorf# = (0d for BIN#4
;Sensor# = 05 for SLOD#O

;Sensor# = OE for SLOD#9
W 04 00 00 ; I2C Write <Slave Address = 04> <0ffset = 0> <SensorIndex = 0>

;IZ2C Read <Slave Address> <Sensor Index, Shits> <RawCount,

I~

igkits> <Baseline, 16,
R 04 ESensor_ Index E@lRawCount @0RawCount @1Baseline E@0Baseline @1DiffCount EODif:

>

Successfully Connected to Bridge/0000011
USB2IIC Bridge version 1.22

(B3]

Power Protocol
- Send all strings: Connected 2C/5PI-USE corverters:
[ oo | =2 ORI Ao
Repeat court: O +33v
0 N Soanpaicd,ms:

[ connected [ Powered | vokage: -

[ 1 [ syneaz:oK Jak.

7. B OK, RREIFEHH,

1.8.2 iHY BTNO (1 & 15115k,
1. Ki% 12C 5484 W 04 00 00 — K.
2. siili Repeat #4#, LUESIRIELLT 12C 454

SEHELR AN A

R 04 @Sensor Index @lRawCount @ORawCount @lBaseline @OBaseline
@0DiffCount @ButtonStatus @SliderPosition

3. i Chart &R, &% BTNO [JRLETHE. FEMES A EE.
1.8.3 2HY SLDO fJRIATHEL. FEELZk . B EEME & E

1. Ki%X12C 5454 W 04 00 05 — K.
2. M5 Repeat %88, LUELERIELLT I2C 52484

R 04 @Sensor_Index @l1RawCount @ORawCount @1Baseline @0OBaseline
@ODiffCount @ButtonStatus @SliderPosition

3. i Chart &IiF, DA SLDO MIJFMATHE, SEHEL . TH BT AL E

WWW.Cypress.com R4S : 001-85848 fiiA*A
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2.1 WHAZK

CE_2_HostCommunication_vial2C_withCY8C20xx6A

2.2 Mk

AR EER 12C IEE WK 1A CapSense®Hef Al — B AIH K I0EHE (R THEEME . FRHELADIRED
K i%45 Bridge Control Panel T.B, {#T#&%&. CSD HiE#uE I CYBC20xx6A CapSense il #} XL, @il
BE B g, T LIRS T b ) BRSO

2.3 WHRE
2.3.1 FER

m  CY3280-20x66 il [l CapSense f2 il # H1 4 AR

m  CY3280-SLM ifi[i] CapSense £ i 415tk

= CY3240-12USB #r#4 8¢ CY8CKIT-002 Miniprog3

m  CY3217-MiniProgl 4228 £ {+8 CY8CKIT-002 Miniprog3
m  USB A # Mini B ki

2.3.2 fHE

& 2-1 R TR E TR, 4 — 22x2_RA_Receptacle # CY3280-20x66 UCC Zf4:F1 CY3280-SLM #iHi%
B K. K5, ¥ MiniProgl/MiniProg3 B I2USB bridge/MiniProg3 &4 £ & 4E () ISSP i I . %% B H
MiniProg1/MiniProg3 i#4T4mfE, 548/ 12USB Mt #%/Miniprog3 #5-5¥E & %4 PC. ), 18/ USB L4 A% s:
F PC L.

K 2-1. tf i BAE

—»[ MiniProg1/MiniProg3 ]—
[ CY3280SLM H CY3280-20x66 UCC ]—
—»[ I2USB / MiniProg3 ]—

WWW.CYpress.com YRS . 001-85848 R A*A
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2.3.3 WHE HHHR

CapSense®z il a3+ Lid 7~ 1

BT DU R IR R

m 4 CY3280-SLM R L4 J1 Fil CY3280-20x66 UCC HiEk#R L) 22x2_RA_Receptacle (iE#HdS P2) iEH:AE
—g.

m TERERE J7 LRRE —ANBEEREE, AT UCC HUER IS Vee A Ve proc #id%. (HBh T E, &bl

ISSP & 4423 CapSense il et i .

AR J4 BB — A BkERAE, B UCC HEEHRIM T XRES A1 XRES/INT (51 1 F1 2) fE:. ZkE
CapSense ##iill#% 1 XRES 5| {iEE: 5 ISSP iE8:4% I3 511 3 L.

TEAGEE J2 bl E — R H%, ¥ CY3280-SLM HiEgHR 951 i GND F1 SHIELD (51 2 F1 3) %5, ik
T CY3280-SLM HEFE AR b 1 kA% B2t

¥ MiniProgl/MiniProg3 #4#:E] UCC HLUEEMR K ISSP il 33 o RA A+ Sl r= A AR R4 2 UCC
I, A%, [/ Bridge Control Panel #{}iil CapSense ¥i#it, ZE M/ 12USB #i#:2:/MiniProg3
8% MiniProgl/MiniProg3 1T %4% .

m il USB A % Mini B 28254 MiniProgl (Y 1I2USB #f#:4%/MiniProg3) 1% —imi&#:#| PC L.

2.4 JRFE

&4

T,

CapSense Buttons Slider
P1]6] 560, 11 PR1[4] SLDO
cap_buto PRO[E] sLbs
PRO[4 SLDZ
P13] 560 2
PRO[2 SLD3
cap_butt PR2[6 sLo4
P3J3] 560, 13 PR2[4] SLDS
PR2[2] SLDe
R7 560 PR2[6 cap_but2
PR2[0] SLD7
p2[7 R6 560 PR2[4 P21 560, 14 ; :; l
P2[7] P2[4] PR3[2] SLD8
L] I—
P2[5] P215] pai2) 34 RS 560 PR2[2] cap_butd i .
P2l R4 560 PR2[0 _uﬂﬁk
P2[3] P2[0] P2[3] 560 15
i — | a2
Palt P2[1] P4[2]
cap_but4
Pa[3) CY8C20866 Pa[0]
] P4[1] P3[6] e
— Pap7) pafa) [FH2— LEDs sv
2 R3 560 PR3[2] T
P3is] Pajg) & LEDO
5
P3[3 — pao) |22 R2 560 PR3[0] P2[5 o' 16
—Li] ey XRES [F2E— LEDT 1K
—t2 o o i P16 P ¥ 17
i) | = o o S &@ =
= 0 o ¥ T % 4+ . O = = 1K
o Z2 Z o o > 0 o > 4o o LED2
Paft iy 18
1K
LED3
PO[5 has 19
5 JJ—K—WL«
B & 1K
= LED4
Piz] N 20

BRI 2.2 nF KIS (Cvop) #H:F] PO[3]5IHI L. 5/ — 560 Q KIHLFHK %> CapSense 124 i BLEE K,
DL /D T4, % LED BCENCHSFE R, JRBHER— 1 kQ M. ZEEE RG4S LED. LM

Je— A

10 AT BUIIE 5%

WWW.Cypress.com
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%% 2-1. LED. &A1 2% BCHOS] A7 BT

LED g WBERE

LEDO - P2[5] | BTNO - P1[6] | SLDO - P1[4]. SLD1 - PO[6]

LED1-P2[7] | BTN1-P1[3] | SLD2- PO[4]. SLD3 - PO[2]

LED2 - PO[1] | BTN2-P3[3] | SLD4 - P2[6]. SLD5 - P2[4]

LED3-PO[5] | BTN3-P2[1] | SLD6 - P2[2]. SLD7 - P2[0]

LED4 - P1[2] | BTN4-P2[3] | SLD8 - P3[2]. SLD9 - P3[0]

25 HRHRE

251 P LR

m  PSoC Designer (A 5.2 85 R RA)

m  PSoC Programmer (JRAS 3.13 B3 @A)
®  Bridge Control Panel T.E

252 M BHAIR
RARBU UL T BRI AR B P B (UMD A UM IR 4 PR R 2.

R BEARRIR

CsD CapSense fiitk, ERf# 1 (BRI

Ezl2C I2C/SPI ik

2.5.3 M HRRSE. &R 5H

T H () ReadMe.txt SCHF U B 1 AR~ T 5 F P RN S 80 B . LA, Bibfefit 17—/ RIRSIE.
R BATHZARED R BT TR, 2 4 CY3280-SLM £ 1.5 mm BRI & &2 . B & %52 E

BRG], IR A/ T 8/ CY8C20xx6A CapSense 72775 i CSD Ak M BRI A .

2.6 #HBAERH

RIS, AR AT DU A

m N AEE MyI2C_Regs DAL S . JRAGTHE. THEBORE HEEZ. T B DU RHZ I8 S 5 R N

f] CapSense PR
m  {ERea R, 85 )H35) CSDUM.
m JHZ) EzI2C UM, RJ5% Myl2C_Regs Z5H1AE E N 12C RAM 201X .
m CRREHHAAT T TR

o GRELFR AR, JFN Myl2C_Regs A TERNRAGTI B, THEOEME . SRAEL . TSRO LB DL E
CapSense 18 HPIRAS . BI85 5 AN F) EzI2C NBas 12C Zenf X — DT A, 12C A BLFRFEA

e CapSense HUE .

o CYECFIBHZ B, ELRARNE LED ARETI#N “ON” (F17F) o BiuLns, LED RESFIKEN

“OFF” (xHD .
o IR, B SK LED MRREDIN “ON” (3T7F) , DUSRRALBIALE .

WWW.CYpress.com YRS . 001-85848 R A*A
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i
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1%

Entmiiadin o CapSense®f il &AL < 1
K 2-2. Ut 2 MZhResiRE

Start Loop forever

4

Er_lable global Scan all sensors
interrupts Update all baselines

v v

Check for active
sensors

Set 1°C RAM buffer

4

Update LEDs

Start I°C
Start CSD UM ¢
y Update I°C RAM buffer with
A. Initialize CapSense CapSense parameters L
baselines (RawCount, Baseline, SensorMask,
B. Set Finger Difference Counts, Slider Position)
thresholds

2.7 PATRILRHI

{E I H g BB, SRS 1 IOZRE P HUT AR R_ B . B R gmfe UCC HERIMNEMELR, S CY3280-20x66

BRI R
1. f##H MiniProgl/MiniProg3 & CY3280-20x66 UCC £ {85 i i N8 AT E — A I R IR L 5 V LR
2. fili CY3280-SLM LR AR _E 2RIt iE 5% .
CY3280-SLM HL R FAHR ) LED # &5%.
3. fbBLRE AN

CY3280-SLM bR s B AR _EARRIH LED B rist SRT DARII A3 2 AN 42e8, o m) DA IR ) e P 2 M2 B2

2.8 &L I°C 2B CapSense ¥i#E

¥ B AZ AR B AT ARG 7~ 45 372X Bridge Control Panel T E. ) CapSense 5. 24 Ml ik T B 1 FE4E

B, 1§5% AN2397 — “CapSense®H#HEH TH” .

2.8.1 Jin#k Bridge Control Panel T. &

1.

1§ 12USB Hid #s/MiniProg3 il USB A % Mini B 4645, K& i+ SEHLAT CY3280-20x66 i ] CapSense 4 il 4%
HLEE AR 1Y) ISSP 4228 I3 K

7ERIN S b, k% Start > All Programs > Cypress > Bridge Control Panel (/#&#) > Bridge Control
Panel (&#A) .

Bridge Control Panel /&7E PSoC Programmer %23 i 4 i 223 (il — AN 4

Nty 11 3B 7 1 AP S T B A

4 CY3280-20x66 CapSense 2 # HLH R I 4L 5 V I HL U

M Bridge Control Panel & M & %%+ File >Open. JNEALRBIT H 30432 H BCP Configuration Files S
S BCP. idc 31,

WWW.CYpress.com YRS . 001-85848 R A*A
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i 7 Bridge Control Panel

Fie Edtor Chat Execute  Tooks  Help

S8E 2R o BEEE

CapSense®z il a3+ Lid 7~ 1

W% $E Charts > Variable Settings. ML R H 2432 1) BCP Configuration Files 243 Py in
BCP.ini Wff.

Edtor | Chan | Table | File |

JIZC Write <Slave Address> <0ffset> <SensorIndex = Sensor#>
;Sensor# = 00 for BINHO

;Sensor# = 04 for BTNH4
;Sensor# = 05 for SLDHO

;Senzor# = 0F for SLDHS
W 04 00 00

; I2C Write <Slave Address = 04> <Offset = 0> <SensorIndex = (>

;IZC Read <Slave Address> <Sensor Index, Bbhits> <RawCount, 16bits> <Baseline, 16.
R 04 @Sensor_TIndex @lRawCount B0RawCount B1lBaseline @0Baseline B1DiffCount @0Dif:
] 2>
~
Successfully Connected to Bridge/0000011
USB2IIC Bridge version 1.22
-
Bomi | 00 o prmr— ] 8% O
ide/00000 4.
= Seanpendne [ o]
[ ran | spntax s ok Jok (0 Conneeted (] [ Pawered [ voltage: -
Y- 23
il OK, AR [AI S| FE M.

SEHELR AN A

1. Ki% 12)C 5454 W 04 00 00 —iX.

2. i Repeat #%8, DLEZEKIE FIA 12C #1454
R 04 @Sensor Index @lRawCount @ORawCount @lBaseline @0Baseline @1DiffCount
@0DiffCount @ButtonStatus @SliderPosition

3. fids Chart $IF, &H BTNO WIJRIATHE. LA S22 M

2.8.3 LHL SLDO HJEaRTHEL. JErEL . iH B EEME & E

1. Ki% 12)C 5484 W 04 00 05 —iX.

2. i Repeat #%8, DLUEZEKIELLT 12C #1184
R 04 @Sensor_Index @1RawCount @ORawCount @1Baseline @0OBaseline @1DiffCount
@0DiffCount @ButtonStatus @SliderPosition
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Apply IDAC Compensation

}

Enable global interrupts

» Initialize Sensor scan loop

A

Scan Sensor <
A
Start CSD UM
4
Calculate sensor absolute
capacitance
UART Enabled? 4
Yes Display capacitance value in
Hyperterminal/Bridge Control NEvE SERser
Panel
i A
Start EzI2C UM
—®
All Sensors Complete
Yes No
Start TX8SW UM |

WWW.CYpress.com YRS . 001-85848 R A*A
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4.7 PATAEE B

HFRUCCH IR
WEHIRAE main.c SCHFhTER T “#define UART” 184), I FIIR3E@IEIT =~ RE, AmIH X T F6 ) , JExt
HLE AR HEAT R . A C 4R UCC FiBRAR IO VEAR(S B, 755 % CY3280-20x66 B4R i Fi 1.

i
Wy
)

750 /% Comment this while using I2C;Uncomment this while using TART */
76 //#define UART

f#F BCP WA= REHiE
4 CY3280-20x66A 1] I3 i FEE R F 12C-USB Hif4s 8k MiniProg3 |, Fflifl USB A # Mini B k45 12C-USB

1.
MrEE 43 /MiniProg3 (1 5 — s BB B HHL L.

2. FEEENSETE L, MKIKi%EFE Start > All Programs > Cypress > Bridge Control Panel (ft4<) > Bridge Control
Panel (fR#) .

3. M Port selection & MG FEATH AT (12C-USB Hr#E#3 8L MiniProg3)

4. @il 57 Bridge Control Panel L) “Toggle power” 48, Ageff{fte .

5. M Bridge Control Panel & K& ki%#% File > Open. M3 H 32431 BCP Configuration Files T3¢ A fin#;
BCP.iic (1.

6. KIki%$E Charts > Variable Settings. M5 H 43¢ /) BCP Configuration Files S {3 A ik BCP.ini 3044«

7. xiih “send” {%Zf#, H§ 1°C $HAKIAL CYBC20xx6 ifilds, ARG & H kUL AR Cp 0 (Nt
#D . R EPR.
o)

5 Bridge Control
File Editor Chart Execute Tools Help
FseE AR OE EEE
[ Edtor [han [ Table [[e_|
-

;Bridge Control Panel reads the capacitance of 5 sensors
;I2C Read <Slave Address> <Sensorl Cp, 8bits> <Sensor2 Cp, 8bits>
;<Sensor3 Cp, 8bits> <Sensor4 Cp, 8bits> <Sensor5 Cp, 8bits>

R 00 @Cpl @Cp2 @Cp3 @Cp4d @Cpb

flas Cp (H Nl i)

R 00+ 11+ OF+ OD+ 0OC+ OB+ p

R 00+ 11+ OF+ OD+ OC+ OB+ p

R 00+ 11+ OF+ OD+ OC+ OB+ p

R 00+ 11+ OF+ OD+ OC+ OB+ p

R 00+ 11+ OF+ OD+ OC+ OB+ p

R 00+ 11+ OF+ OD+ OC+ OB+ p

R 00+ 11+ OF+ OD+ OC+ OB+ p E|

<

Cnrneded IZC/SPVRXB Foﬂs Pomves
(@eset | it [ Fend | RS::: ‘. o] o R— ‘E oun e
count: com3 433V SPI
| Eoor [ epeat [ Brotie ] Scanperod, ms: [ 0j] |COM W g ﬁg © RX8(UART)

Protocol

[5:31 [syntax:0K [Ct=457 Rate=387 smp/s |11 Clnmeskest 1| |\ Bowered ] Voitage: 5000 my

WWW.Cypress.com A4S 001-85848 fiLAN*A
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File Editor Chart Execute Tools Help

FUE SR CEEEER Cp (k%D

| Edtor [ Chart | Table |[Fie
# Cpl Cp2 Cp3 ot o5 / -
0 17 15 14 12 1 E
1 17 15 14 2 1
2 17 15 14 12 1
3 17 15 14 12 1
4 17 15 14 12 1
5 17 15 14 12 1
6 17 15 14 12 1
7 17 15 14 12 1
3 17 15 14 2 1
3 17 15 14 12 1
10 17 15 14 12 1
11 17 15 14 12 1
2 17 15 14 12 1
13 17 15 14 12 1
14 17 15 14 12 1
15 17 15 14 12 1
16 17 15 14 12 1
17 17 15 14 2 1
18 17 15 14 12 1 J

Connected 12C/SPI/RX8 Ports:

Send all strings: MiniProg3/1229DD001569 Power Protocol
Reset it Send @ +50V
Kl ’ nmm%ﬂ% ©+3.3v 4
oBtlon] (e o] OO

© *25v
©® | 0w ©;Fua UAD)

[5:31 [syntax:ok [Ct=457 Rate=387 smp/s || Connecied || Powered | voltage: 5000 my

HFRUCCH IR
EUE “main.c” sIiEREES) “#define UART” (I RIEERIEIT ), ARJE A4 i H 9E40 82 UCC HES IR .

T5iE /* Comment this while using IZC:;Uncomment this while using UART */
76 #define ULRT

f#F HyperTerminal Wik R %R

1. f#H Miniprogl B¢ Miniprog3 % H AR it L .

2. (ERKSE b, fRik%E$E Start > All Programs > Accessories > Communication > HyperTerminal.
3. NZEEBEAAR.

4. pidi OK.

WWW.Cypress.com RS S: 001-85848 fRAN*A
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1k

\

Connection Description

% New Connection

Enter a hame and choose an icon for the connection:

MName:
lAbsCap_measurement I

lcon:

[ 0K ][ Cancel ]

i “Connect using” HEHHI T HiglR, EHFHFEIK PSoC 4R M & 4T .
Hi OK.,

Connect To E] @
% AbsCap_measurement

Enter details for the phone number that you want to dial:

Country/region:

Area code: [:]

Phone number: [ ]

Connect using: | ETIETIGG ~ |

[ oK ][ Cancel ]

7£ COM Properties SHEHEF, FLELL NS4
Bits per second (& 47%0) = 115200
Data bits (F#Efi%0 =8

Parity (Zf&PE) = None ()

Stop bits (fF1EAED =1

Flow control (JifE#%fi]) = None ()

miff OK. HyperTerminal ZEHE R 5E 1) COM i 1, RL IR BER W] LA .

WWW.Cypress.com A4S 001-85848 fiLAN*A
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CapSense®z il a3+ Lid 7~ 1

COM>S Properties @

Port Settings I
Bits per second: |115200 Vl
Data bits: ’8 vl
Parity: ’None vl
Stop bits: ’1 v}
Flow control: | vf
[ Restore Defaults ]

I 0K I[ Cancel ][ Apply

]

9. JEHEIEAL UCC HEIR.

KN, IR 4SS A0k 2R 7E HyperTerminal & H A,

WWW.Cypress.com

WAYYRS: 001-85848 iR A*A
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B Embedded in Tomorrow”
& AbsCap - HyperTerminal
File Edit Viem{” Call Transfer Help
DE @38 DB

Absolute Capacitance Measurements:
Sensor(0) Sensor{1l) Sensor(2) Sensor(3) Sensor(4)
16pF 15pF 13pF _ 12pF 11pF

Connected 0:02:11 Auto detect 115200 8-N-1 AP

WWW.Cypress.com
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A%~ %] 5 i CY8C21x34/B

CapSense 17 il I 5 (1 45 % 1oL 2

‘z
CYPRESS

Embedded in Tomorrow™

fy

!!!!!!!-

5.1 TiHBHK

CE_5_MeasuringAbsSensorCap_withCY8C21x34

5.2 M@

ZAIL R B CY8C21x34/B CapSense®#zfil#iil 5 5 ML LT EZE, @il Windows HyperTerminal =k
Bridge control panel 44 H B RTETHEANL B T2 B 4axd AR KRG ¥ N 1 pFo

5.3 WHRE
5.3.1 3k

m  CY3280-21x34 i ] CapSense il #%

m  CY3280-SLM i#ifi] CapSense 2P & ibith

B RS232 W AR

m CY3240-12USB #4438t CY8CKIT-002 Miniprog3

= CY3217-MiniProgl Zwf£#5 8 CY8CKIT-002 Miniprog3
m  USB A Mini B ki

1BATHE4 Windows XP 85 = A ) PC

5.3.2 I

B 5-1 j#R TR E 7. #TH 22x2_RA_Receptacle ¥ CY3280-21x34 UCC £ {fi#E#F| CY3280-SLM itk I,

# MiniProg1/MiniProg3 #8143 |, M4 % Bt x5t Lk gmfe .

{# HBridge Control Panel# {43 it 12C-USBHr 43 BiMiniProg3, 1 LL{EPC & Hf£/E45Cp.
@it HyperTerminal 3% f RS232 JE{5 i), ATLAYE PC EEHE s

P 5-1. fi 14 B HE P

—b{ MiniProg1/MiniProg3

[ CY3280SLM }—b{ CY3280-21x34 UCC j—

{IZUSB / MiniProg3/RS232

Level Translator

WWW.CYpress.com YRS . 001-85848 R A*A
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5.3.3 ZH3EH R
T FEHEAT LR A

# CY3280-SLM FEHUHEAE J1 RS CY3280-21x34 UCC 4 ) 22x2_ RA_Receptacle (Z#:%s P2) L.

TEAG R J1 R — M2k, 3 UCC HESIRAIEI I Ve M1 5 V 55 HE. 1ZW B RES i ISSP #3243y CapSense %

e L .

R J4 bR Bkeks, K UCC HERSIE XRES Ml XRES/INT (51 1 1 2) H#. ZRKESE

CapSense il #5 1) XRES 5| HEH:ZE 1ISSP &4 I3 5] 3 L.

TEdE J2 LiEH—AMhekas, 4 CY3280SLM HEESHR Y51 f GND F1 SHIELD (5l 2 fil 3) . % ESE

CY3280SLM Hiig i _F i RIRE 423t

# MiniProg1/MiniProg3 %] CY3280-21x34 UCC K J3 i L, LAZmFERRM:.

nSE 12C B UM S TR LB S A Cp, 15K CY3280-21x34 1 I3 4 EIERE S 12C-USB sy

IMiniProg3, JFilid USB A # Mini B 40K iZ A2 88 1) 59 — i 2 2 iH L. il 27 Bridge control panel L [¥]
“Toggle power” fuies e tHfkH.

@ UART £ HyperTerminal FEEfEEEE Cp, 15 RS232 B #kas AR L1 TX 5] iE#:3] UCC 1)
P1[7]E. 4354 f P e B % (1) Vee A1 GND 5| i #:%) UCC ) Vee Al GND 51 Jil_E. RS232 Hi PiE#ss it — R
IR R MAX 232 ERAT H T 08

A5l P ER AT R BORE LT H2 HLBR AR 1) RS232 diy FHE RIS L.

WWW.CYpress.com YRS . 001-85848 R A*A
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5.4 JRIE

CapSense®z il a3+ Lid 7~ 1

CAPSENSE BUTTON

<
o

10 uFd 25v g

56

"l

vdd

Cmod

PO[3]

RS 15K .
o N P1[6] N

B1 P1[3 = 3.0nF

C2

SR BNEOS
N URBNES

iadasaa

WNE S

NEaRNENEE

0 [0|0|0 |00 (0|0
(S]] S IN] (] (W] (N (=1

19333013

R

G =Y=)

<SELKN

100

Vss
Vss
Vss
Vss

7
8

1 R3
7 RS 560
2 __R7 WEGO
6 __R10 560
R12 560
W 560
R17
R19 560
=’ 560
R21
mm_ 560
R24
R26 560
W 560
D
9
o
36 X
7
8
9
40
i
47
CY8C21x34/B

& 5-1. AUl 5 # 512 BS

Pup3 Gl
B0 P1[6]
g 1 P1[3]
ik 2 P3[3]
TeH 3 P2[1]

Cwon PO[3]

Rb P3[1]

5.5 HHRE
55.1 riff TR

PSoC® Designer (hii7 5.2 3 F i A<)
PSoC Programmer (g7 3.13 55 &R 4)
Bridge Control Panel # {4

Windows HyperTerminal %

WWW.Cypress.com
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55.2 H#BaR
B TIZAEDRGI AT IR PR (UMD BAB&A UM R o IR 05

F P B HIR
CSD CapSense fiith, w2 1 (BRI
EzI2C 12C Bk

TX8SW A B RSB

55.3 RS H. &RBK
BUH iy ReadMe . txt SO T AT R G M & S MO SHB R . BEoh, EIEIREE T — 2R IS

s

5.6 AR
BT T BLF AR H S A R B B

Raw Counts = C, . Sensitivity

Hrr, Cp ALK A
BRI, A8 A A R a4 R 2 ) B S B AR IR 2R W 4 0 AR
ZIH A —A4N 4N CY8C21x34/B_CalculSensitivity.xls I3CfF. IS T RBUEMEMITTHE. TR “Ref
Value” (Z%1H) A1 “Prescaler” (Fi/rias) S¥0nl ks L it
m  RefValue =5
m  Prescaler =
I%azf%?”ﬁ”TEmﬁf/HQ@ﬁ%?FETE b
1. fFRZAECER, THHE MR BUEET 465 1H45UpF. 1523% CY8C21x34/B_CalculSensitivity.xls.
% “XIs” SCAFRINE I—ERSy, EARAEEAETI H ST
fiEfeam b, IFEBIH P,
F5 St AN R AR 3R AT 3, IR CSD_waSnsResult[| %41 H 3R BURE 4615

A R A THECS RO R LBk o R A I A0
BaE R IESTEENL, FERIE R P ik, B ILE R Bridge Control Panel 5§ HyperTerminal .

a s wbn

WWW.CYpress.com YRS . 001-85848 R A*A
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"M

K 5-2. AL~ 5 FIThRE R

Start

A

Enable global interrupts
Loop forever

|

Start CSD UM

Initialize Sensor scan loop

A

Initialize baselines, Set Finger
Threshold

A

Scan Sensor

A

Calculate sensor absolute

UART Enabled?
Yes capacitance

Display capacitance value in
Hyperterminal/Bridge Control N SEEaD

Start EzI2C UM Panell

—®
Y
Start TX8SW UM
All Sensors Complete
Yes No

A

Call DisplayMessage()

5.7 HATRIGRHI

40 2 FL R AR
EHRAE main.c XN T EREIER) “#define UART 7
BRMCGHAT AR . A e il 4m e UCC BRI RS R, 153

I FREEETR) » RIGERIE GZF F6 ) It
%% CY3280-21x34 B faE P IS HET.

R4S 001-85848 iR A*A

WWW.Cypress.com


http://www.cypress.com/
http://www.cypress.com/?docID=36453

—wwe CYPRESS

78 //#define UART
758
f# /3 BCP ML REB LR
1) K5 CY3280-21x34 1) I3 4 Ji i 4 3| 12C-USB #r £ 4% 8 MiniProg3 I, Jf i id USB A% Mini B % 4i ¥
12C-USBH 2 #8/MiniProg3 1) 5 — i & # 2vH HHL L
2) eI E, Rk EEStart > All Programs > Cypress > Bridge Control Panel f&Z) > Bridge
Control Panel (FRA) .
3) M FIEHFRE 1 Pk AR
4) °HCY3280-21x34 UCCEM: Hi IR IL LS VI FLIR .
5) 7EBridge Control Panel& 19, {KixiZF#File > Open. MIiH C4IEHFBCP Configuration Files3C2F &P
I BCP.iic 3.
6) fkikik$ECharts > Variable Settings. MIiH U I 1)BCP Configuration Files At J¢ A in#BCP.inis .
7) i “send” 1%, IPCHEA RIXL CYBC2Ux34 45 il 2E, AT E SR HS & 1 A IREUL B Col . (TN
&), R E R
5 Bridge Control Panel.

Embedded in Tomorrow” Capsense@)%%u%&ﬁﬁg%%

g /* comment this while using I2C;Uncomment this while using ULRT #/

File Editor Chart Execute Tools Help

s EERROEEEE

Editor | Chart | Table | File

;Bridge Control Panel reads the capacitance of 5 sensors
;I2C Read <Slave Address> <Sensorl Cp, 8bits> <Sensor2 Cp, 8bits>
;<Sensor3 Cp, 8bits> <Sensord Cp, 8bits> <Sensor5 Cp, 8bits>

R 00 @cpl @Cp2 @cp3 @Cpd @Cp5

&t Cp CHo ikl HfE)

<

R 00+ 10+ OF+ OD+ OD+ OB+ p
R 00+ 10+ OF+ OD+ OD+ OB+ p
R 00+ 10+ OF+ OD+ OD+ OB+ p
R 00+ 10+ OF+ OD+ OD+ OB+ p
R 00+ 10+ OF+ OD+ OD+ OB+ p
R 00+ 10+ OF+ OD+ OD+ OB+ p
R 00+ 10+ OF+ OD+ OD+ OB+ p

WWW.Cypress.com

«
Connected 12C/SPI/RX8 Ports: Powves et
[ [ nge:
Bro | s | oo | Serdasunas opiegyi22s0000i563 \E o e
=3 = = g2y |0
~ — i < - +2!
Scan period,ms: [ 03] Gl @ oo ||© e
[5:31 [syntax:oK [Ce=670 Rate=443 smp/s |1 onneeted | | Powered ] voltage: 5000 mv

R4S 001-85848 fRA*A
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% Bridge Control Pane
File Editor Chart Execute Tools Help
FEE SRR CE BEER Cp Tt EfE)
| Edtor [ Chart | Table |[Fie
# Cpl p2 3 Cpd o5 / -
0 16 15 13 13 1 B
1 16 15 13 13 1
2 16 15 13 13 1
3 16 15 13 13 1
4 16 15 13 13 1
5 16 15 13 13 1
6 16 15 13 13 1
7 16 15 13 13 1
8 16 15 13 13 1
3 16 15 13 13 1
10 16 15 13 13 1
11 16 15 13 13 1
12 16 15 13 13 1
13 16 15 13 13 1
14 16 15 13 13 1
15 16 15 13 13 1
16 16 15 13 13 1
17 16 15 13 13 1
18 16 15 13 13 1 |
@Feser || Fstim | Fseng | SO - |com g‘l;d
peuod.ms. © RX8(UART)

| 5:31 [ syntax:0K |Ct=679 Rate=443 smp/s

RTEHERIR
7E “main.c” FEUEERBIES) “#define UART” (IO FEIFTR) , TR H IR .

Tei0 /% comment this while using IZ2C:;Uncomment this while using TUART #/

. |

=]

-]
[T I &+

$define TART

£ HyperTerminal 4% R a8 5045 .

{4 FMiniprog 1 B Miniprog 325 F, M AR it F .

e S -, MK IkiEIEStart > All Programs > Accessories > Communication > HyperTerminal.
NZIEFEN LR

MFOK I

PwbdPR

WWW.Cypress.com RS S: 001-85848 fRAN*A 44
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5. i “Connect using” HEF I TR FIER, LA THILPSoCHE It &

Connection Description

% New Connection

MName:

Enter a hame and choose an icon for the connection:

CapSense®z il a3+ Lid 7~ 1

lAbsCap_measurement

lcon:

FERATHR B, A2 COMS,

6. i “OK” .

Connect To

% AbsCap_measurement

Enter details for the phone number that you want to dial:

Country/region:

Area code: [:]

17 % H

21X

Phone number: I

Connect using. | EETERN ~ |

[ ok

][ Cancel ]

o ZWEFEPCH B AR

6. fE “COMJEME” XHEHEF, FLE LTS
o Bits per second (%0 = 115200

o

o

o

o

Data bits (F#Efi%0 =8
Parity (ZfH™) = None (B)
Stop bits (fF1EAED =1

Flow control (iis##]) = None ()

7. mii OK.
HyperTerminal #5355 ) COM 35 1, DXt st e T A A 2 o

WWW.Cypress.com

R4S 001-85848 fRA*A
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\

COMbS Properties

"ot Seings |
Bits per second: |115200 v’
Data bits: [8 vl
Parity: [None v}
Stop bits: ’1 v )
Fiow controt | (RSN ~ |

?)x)

CapSense®z il a3+ Lid 7~ 1

' 0K I[ Cancel ][ Apply ]
8. JEMIFEN UCC HLERHR »
X, 3RAR M4 T R 7E HyperTerminal & A,

¢ AbsCap - HyperTerminal D@@
7File Edit View Call Transfer Help I
D @8 DB

Absolute Capacitance Measurements:
Sensor{B) Sensor(l) Sensor{2) Sensor(3) Sensor(4)
16pF 15pF 13pF 13pF 11pF
Connected 0:00:55 Auto detect | 1152008-h-1 | -FCLL -APS | NUM

WWW.Cypress.com
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6.1 WHAZK

CE_6_MeasuringAbsSensorCap_withCY8C20x34

6.2 Mk

ZARIS R 11 CY3280-20x34 CapSense®¥z il 25 Kt 5 T ME KBS %) 2 . MR A2t SRS N 1 pF.
6.3 W RE
6.3.1 Ek

m  CY3280-20x34 it ] CapSense il #%

m  CY3280-SLM i fil CapSense £ 1115 s itk

= CY3217 — MiniProgl %43 8L CY8CKIT-002 Miniprog3
m CY3240 - 12USB %A B CY8CKIT-002 Miniprog3

m  USB A # Mini B 245

m A Windows XP B B A1 PC

m %

6.3.2 fHEE

B 6-1 R TR E 0. CY3280-20x34 UCC Effi@it 22x2_RA_Receptacle ##:%| CY3280-SLM. #
MiniProg1/Miniprog3 i E i FE I3, M4 iZE M I HiE T RFE

Pl 6-1. B i EAME ]

—»[ MiniProg1/MiniProg3 ]—
[ CY3280SLM H CY3280-20x34 UCC ]—
—{CY3240 I2USB/MiniProg3]—

WWW.CYpress.com YRS . 001-85848 R A*A
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6.3.3 ZH % HL AR

AT DU R

m 4 CY3280-SLM T RAgHEEE J1 #HF] CY3280-20x34 UCC HLEEHR 1] 22x2_RA_Receptacle &R P2) .

AR 01 BBk ER, % UCC FEEEAR UG Vec F1 5 V fiE: . 1% B e ISSP %8245 4 CapSense ##
e L .

m TEHRJE J4 LiEE—ANBEZEEE, B UCC HEERIIGI XRES F1 XRES/INT (31 1 Al 2) . ZE BN
CapSense #iill#31 XRES 5| J{iEH: 4 ISSP %24y I3 1951 |1 3.

m TEHRAE J2 BiERE—ABRZREE, ¥ CY3280SLM HLEAR KI5 B GND Al SHIELD (5IfHl 2 1 3) 4HH:. ZiE off
CY3280SLM Hiig i _F i RIRE 423t

= % MiniProgl/MiniProg3 Z#:% UCC HESHRAT ISSP i) J3 Lo R/ bl o= RIS R gmfE UCC
B, AHREZERE. 8@ Bridge Control Panel #f}H Il CapSense %4, M4 FHFEMEH 12USB &
MiniProg1/Minirpog3 AT

m  f#f] USB A # Mini B ££454 MiniProgl/Miniprog3 (B I2USB HF%8%) % —ii%E# %= PC L.

6.4 FEHE

VDD
L
s Gt
10 uFd 25v g
U1 -
Polal R1 71— P10
)| o
EE[Q] AR % PO] > PIT |37 e : itz
Crmod  R7 560 46| Pol2 P12l 55 Re T P13
E RO /560 36 | POI3 P1i3] 55 Rio T 4]
c2 o5 1T 560 45 | PO4 P14l 90 Ri2 T 5
POl R13 560 40 | POIS P12 R1a /560 Pils
Bo e P1[6 gs.QnF PO[7 R15 W%% 44 Po[7 P17 9 R16 W% P1[7
B e = e %5 Pelo T TIAAYAT T
P2z RS 31| P2 P3(1] 55 R23 "’ 560 P32
B2 P33 P23 RZ 5 | P2[2 P32] |7~ Ras 560 Pa[3
Pala RS 32 | P22 P3[3] 560
Pa[s) Rz 1 gg‘; ’
£ -
B3 P2[1 ES § w sg pae YRES 627 Reg, - XRES
KA P2[7 ;
P2[3 o NG —7
B4 NC 7>
NG 5+
CAPSENSE BUTTON HOLK  Raz.™ 19 NC e
CCLK R3% 100 75 | HOLK NG 53
OCD0O 00 4z | CCLK NG [53 %
OCDE 00 43 | 9GDO NG [54
o0 OGDE NC 55—
NC 55—
NG |ag—%
NC T‘(
won NG X
wnW
>=>>
nt v CY8C20434
CYBC20xx34 CAPSENSE
CONTROLLER BLOCK
N
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PHHI IR (Cvop) & —MEHEZE PO[B]IE B A/ 3.9 nF K%, 7E&A> CapSense 4 I BB —4 560 Q K
BH, CAsk /> BT

* 6-1. Rl 6 1951 B2y i

i 51
0 P1[6]
1 P1[3]
2 P3[3]
3 P2[1]
4 P2[3]
6.5 HHKRE

6.5.1 FHEMITH

m  PSoC® Designer (JiiA 5.2 85 B RAD
PSoC Zifids (hiAs 3.13 B EE b4

®  Bridge Control Panel T.E

6.5.2 M EHE|FR
TR T AL 1 b T O PR (UMD RIS UM 7 5 T O 2

2i)ar: =S BEAFBIR

CSA_EMC CapSense fik, iR (BRUO

EzI2C I2C/SPI

6.5.3 MRS HL. 455K
5 F 11 ReadMe.txt SCHFHT T ZAIDROUFTE M 0% T BRI SHOR T JEAh, EEHRMET — AR VISR,

6.6 #HIEULH

main.c SXIFHPIANEREL EXTFR IS MEREK IDAC %, AR5, BRI R E S M H, A AT L

i VYU BE N B R . ATV AR A T SRR A I a0 LA

measured

G = IMO
x 1.3

Hr, CprfhBas iz,
APPSR T LA T AP ER:
S FAN L cale_IDAC il source_IDAC, SR JEHRAE FH P i N (B SR 1 e — S R 2
m % calc IDAC ST DL ERIE:
o B NS balDAC, VIR#EALIER 5 R A-#E R CapSense 1424511 IDAC AR,
o CRZBESIRE N 12C X .
o fEREAERITNT, SNE R EhE .
o (ETHRAER T, ARKEREAME A, IR GEERE S P ¥ IDAC TS, BLAh, B ST 12C X
m 3 ER%T source IDAC S HAT UL R HR1E:
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o K PL[4]6C B A High-Z 3R3h 1% H 51 .
F 5 PLADER R NI A a2k b
BEEUH PN IDAC AR

TEGI I PL[A] EHAAH B2 ) H

o

o

o

K 6-2. ATt 6 HIZhRERAE

“calc_IDAC” function “source_|IDAC” function

Configure port pin P1[4] to be output

Define an array to hold the IDAC code
pin with High-Z drive mode

for each sensor

I I

Enable global interrupts Connect P1[4] to the internal analog
MUX bus

: ]

Start CSA and EzI2Cs UMS

Set the array as I°C buffer Take IDAC code
i from user
> Initialize sensor scan loop i
Set IDAC source as per IDAC code
L entered by user
Scan one sensor —— i
L Turn on IDAC to source on P1[4]
Update I°C buffer array with IDAC
code of the sensor N
ext sensor User to read current flowing through
2 P1[4] with a multimeter

I

User to calculate Cp from the equation

All sensors
complete?

6.7 PATARIGRHI

I H g fE AR, SRS RIZARE P BT RIS R . A TR UCC HESIR M TEAE(E &, 155 % CY3280-20x34 Eff
R R L.
1. ffH 12USB Hr#E#3 Al USB A %% Mini B 45, K& HITHENLAN CY3280-20x34 il [l CapSense 2 il #5 HLEE AR 111

ISSP # 4% I3 HH LK,
2. fEHMNSEE F, kit Start > All Programs > Cypress > Bridge Control Panel

Panel (4 .
Bridge Control Panel f& PSoC Programmer %3 i — AN 14

3. M Port selection & 11 w3 S0 N 1 3 4%

(#&4) > Bridge Control
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Jy CY3280-20x34 CapSense 4l #% FLEEHR I (L 5 V I HLI,

7 Bridge Control Panel & I+, #iki%#% Tools > Protocol Configuration. 7E 12C &£, ¥ 12C Speed #
H N 100 kHz.

RIRIEFE File > Open. MR35 H SC1F 3 1) BCP Configuration files SCF & ing Bcp. iic 3XfF.

o &

o

K 6-3. TEARAE 1 R AR

Fla  Edie  Chat  Ecece  Tods  Help
FEE LR CEEEE
Edict | Chart | Tabe | File

W OR 00 ; 120 write <sSlave

ainink IDAC for sensor #0> <variable containing IDAC for sensor #i>

T OBA x x x x x ; I2C Read<

Select Port in the PortList, them try to connect
Opening Port

Successfully Connected to Bridge/0000011
USBZTIC Bridge version 1.22

[his window shows statue o performed conmands and resamed data]

Prawer Frolocol
r Send ol stings: [ Connected 120/5PUSE comvesers o e
% Foerd | ot cont [0 " |85y o=
o] Repest [T]

B0 | gan pee ma: [E

EETTT I | Comedsd || Powered | uokage -

7. ¥ F[Enter]##, 4T Bridge Control Panel {15 —/ME4
RAEE K R BT £ & 251 IDAC 114,

8. R IAMEEIR T M IDAC )5, FTIFIIH, BUEXER) source IDACORIERE, HXHiEHA) calc_IDAC()WIN
TR, DA T PL[4] FAH R I IR

9. fEIhAE source_IDAC()H, iEid4: IDAC_D BE/HLE Y-/ HEHIEME, # IDAC RSB TR — ME AT
Bridge Control Panel §1 E\ 345 4R .

10. f# M  PSoC Designer % # W H . & Wk & &F Build > Generate B
CE_6_MeasuringAbsSensorCap_withCY8C20x34 T H . Hfi{RAE S PRI FE A K AAT I AR B

11, FEREAE AR A S HER SCE R RAE UCC, KKk Program > Program Part.

12. f£ Program Part & 1/, BiilC&EEH: 7 MiniProgl/Miniprog3. R ARER:, & A Connect #%% .

13. #ids Program #%4t.

14. BiJF CY3280-SLM Hi## i A1 UCC (¥

15. S di i EE, oA UCC A1 MiniProg1/Miniprog3 JE H .

16. {5 S A BCE — AN HERR, WEIEIT P1[4](Imeasuren) I HLT -

17. fFH T2t H Ce:

measured

C, = ——measured
<IMO/> x 1.3
8

Horr, IMO RGN BE. EATE S, EHEN 12 MHzZ.
18. EELIR O F 17, DKHUHADALIRIZT Ce {H.
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% 6-2 5| T CapSense 1%/ Cp i LA S IE

* 6-2. PEFM Cp

CapSense®z il a3+ Lid 7~ 1

T Bridge Control Panel 375/ IDAC UL A1 5] fil_Ef) IDAC HLift.

CapSense {£/&#% IDAC % | ¥ D51 L/ IDAC B (pA) WWEBK CofE (pF
P1[6] 0A 28.0 14.40
P1[3] 09 25.3 12.98
P3[3] 08 22.6 11.58
P2[1] 07 19.3 9.90
P2[3] 07 19.3 9.90
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7.1 WHAZK

CE_7_TuningCSD_withCY8C20xx6A

7.2 M

ZACHY 7R B R T AT AR CY8C20xx6A ¥ 4% ) CapSense® UM #ith, ZAHHK CapSense UM, LAIEFE
CapSense HIEMEMER. ZRERFEH EzI2C UM JHEid—% 12C B&M—1 12USB MrEeds kAL bT 75 21
CapSense Z¥. ‘E{#H 7 PC L] Bridge Control Panel %k & & $if .

7.3 WHRE
7.3.1 FER

m  CVY3280-20x66 ifi [T} CapSense 12 fill % B A

m  CY3280-SLM ifi[i] CapSense £ i 415tk

= CY3240-12USB #r#4 8¢ CY8CKIT-002 Miniprog3

m  CY3217-MiniProgl 4228 £ {+8 CY8CKIT-002 Miniprog3
m  USB A # Mini B ki

3 Windows XP B SR A PC

7.3.2 fHE

7-1 % VRIS E TR I —1 22x2_RA_Receptacle ¥ CY3280-20x66UCC E {41 CY3280-SLM il
ik . ¥ MiniProgl/MiniProg3 B{ 12USB bridge/MiniProg3 i# % %) £ {1 ff) ISSP #f )& k. % & & & i
MiniProg1/MiniProg3 #:T4mfeE, i 12USB Hi# s /Miniprog3 K ¥idiE K i%k4h PC. fii ] USB £k &1 1iER:3] PC
.

B 7-1. i B AR

—{ MiniProg1/MiniProg3
{ CY3280SLM H CY3280-20x66 UCC j—
—{CY3240 12USB/MiniProg3
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7.3.3 ZHELHIERIR

T EREAT P B

m }§ CY3280-SLM 7R #i & J1 il CY3280-20x66 UCC i iR (¥ 22x2_RA_Receptacle CGEE:E P2) ek .

m FEREAE J7 BJSE MBS, K UCC HERIRISIIE VCC Fl VCC_PROG #i#k. 1% B RIS ISSP & A
CapSense il # L H

m EEE 34 RIS -ANBREAE, ¥ UCC SRS XRES A XRES/INT (5l 1 F1 2) 4k, &%iESH
CapSense %l % (1] XRES 51l % ISSP & # 4 I3 I 51 3.

m FEAEPE J2 B ABEZAY, K CY3280SLM HLESHR K51 GND A SHIELD (51| 2 1 3) Fifk. iz E &l
CY3280SLM Hi AR L ) P 4% 3t o

® K MiniProgl/MiniProg3 #4541 UCC HLEEHR 1 ISSP i I3 Lo A 448 A 7Sk il Ok = A AR RS ke 4 #2 UCC

B, A B ZiEs:. B8 Bridge Control Panel ¥ {328 CapSense #i#i, M4 FZEMFA 12USB M di s
MiniProg1/Miniprog3 #4734 #

m  f#f] USB A # Mini B 2845 5k2% MiniProg1/Miniprog3 (B 1I2USB Hr%#%) 1% — %3] PC L.

=
& CapSense Buttons Slider
Cmod Pi[6] 560 11 PR1[4 SLDO
2.2nF =
cap_but0 PRO[6 Lot
= = sV PROJ4: sLD2
gl = | g P1[3] 560 12
PRO[2’ : : : : SLD3
4 4 4 4 cap_but1 PR2(E .
U1 P3[3] 560 13 PR2[4 SLDS
é: % ‘lg g % % % § % % g g cap_but2 PRz[2 sLbe
a & -
1 NG P2[6] R7 560 PR2[6 i -
P2[7 2 R6 560 PR2[4 P21 560 14
’ Pl Pai) PR3[2 SLD8
Falsl 3] RS 560 PA2(2]
P2[s] P2[2) cap_butd PR3[O su09
P2[3 4 R4 560 PR2[0
P2(3) P2|0] P2[3] 560 15
P2 s
! Part] paje) F2—
cap_but4
—E pap3) pajo] [FA1—
CY8C20666
— 2| papy) Pate] [FR2—
—8 pap) paj4) 22— LEDs -
Tx -T-
[N ) R3 560 PR3[2)
Pa[s) P3[2) LEDO
P38] 10} 5
P3[3 Pap) Pal0] R2 560 PA3[0 P2[5] = 18
1
—11 ] papy) XRES [F2E— LED1 K
12 25 P1[6 P2[7 s 17
Pilllg 5 = o a =
T 0 Q0 =T T o + a - 1K
a =z Z o o > 0 o > o LED2
o[t A 18
1K
| LED3
3 5 POI5] s 19
[ I @
& 1K
= LED4
Pi[2 ¥ 20

&7 (Cwmop) RN PO[3]51 LIS 2.2 nF R/NRHIZ . /] —> 560 Q HIHIH A k%> CapSense 1%,
DARRACSH ST, ¥ LED MLE MK FAR, HHHE 1kQ MR BER. ZREEERLE A LED. HA 4
DA — AN 10 AN 0] BT 4%
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K 7-1. LED. ZHEAIVEELR 5] 45

LED ek WBERE
LEDO - P2[5] | BTNO - P1[6] SLDO - P1[4]. SLD1 - PO[6]

LED1-P2[7] | BTN1-P1[3] SLD2 - PO[4]. SLD3 - PO[2]

LED2-PO[1] | BTN2-P3[3] | SLD4-P2[6]. SLDS - P2[4]

LED3 - PO[5] | BTNS3 - P2[1] SLD6 - P2[2]. SLD7 - P2[0]

LED4 - P1[2] | BTN4 - P2[3] SLDS - P3[2]. SLD9 - P3[0]

75 BHRE

751 Prai LR

m  PSoCP® Designer (A 5.2 S5 = fRA)

®  PSoC Programmer (JRAS 3.14 B3 SRRA)
®  Bridge Control Panel ({7 iR

7.5.2 PR RFGCE
TRIN T %A B R 0 R 2 e DA % %A R P BB B o R B 5 R«

F s HE
CSD CapSense i, EHf 2% 1 (BRI
EzI2C I2C/SPI

7.5.3 HAPEHSEH. 2HRH

T H (1) ReadMe. txt SCHF U T AR~ i i (s I PSR I S 80 B . A, Bttt T — 2R RIESIE.
R ATHZARED BT TR, 2 4 CY3280-SLM £ 1.5 mm BRI & &2 . B EH A G R

1 8= AR 7R 1 Lﬁ&ﬁﬁlﬂtﬁ%TﬁJ*FﬁﬁE’JP\Jﬁlﬂﬁlﬁ Ho

7.6 #BAERH

RIS, AR AT DU £

nE AR MyI2C_Regs BUERAREES S AR, TIHGEM. HEAE. OB L R R e AR

f] CapSense PR
m fRe R, A5 H3) CSD UM,
®m  JHZ) EzI2Cs UM, #RJ5¥ Myl2C_Regs MR E N 12C RAM 254X .
m CRREHHAAT T TR

o SREEFRPTA AR REE, I MyI2C_Regs SRR AGTFEG. THECE R, FEMELR. WSRO AL E DUk E
CapSense % HPRE . ERDFH LS 5 5 A2 EzI2C W& 12C b XIS — A7 5 A,

FRE T8 CapSense i&%&

o CYECFIBHZ AR, E KA LED ARSI “ON” o BiULn, LED RELTIHN “OFF” .

o il AT, [E 2K LED H’Jﬁﬂ&ﬁ]?ﬁ%jﬂ “ON” , VIFIRfiihiE .
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K 7-2. s 7 IZhResiRE

Start Loop forever

4

4

Erjable global Scan all sensors
interrupts Update all baselines

v v

Check for active
sensors

Set I°C RAM buffer

4

2 Update LEDs
Start I°C

Start CSD UM ¢

Update I1°C RAM buffer with

A. Initialize CapSense CapSense parameters
baselines (RawCount, Baseline, SensorMask,

B. Set Finger Difference Counts, Slider Position)
thresholds

4

7.7 PHATARG B
I H R g A BRI, AR5 R BT RS Rl . A Rl g UCC MBS PRANME B, W3 L CY3280-
20x66 B R 58 L E I 2 .
1. {#H MiniProg1/MiniProg3 5t CY3280-20x66 UCC £ F /-4 AR 1% i R AR B2 A4t 5 V (1 FL iR
2. fili CY3280-SLM LR AR _E 2RIt iE 5% .
CY3280-SLM H R FAHRF) LED £ fi5%.

3. FREIEANERE.
CY3280-SLM b AL B _EAHS ) LED 2 s, 4H] LA bl 2 A F . o] DA P e Mk i A A2«

7.8 J@iT 1°C 2B CapSense ¥

$ W% AR FF AT ARG 2R 45 312X Bridge Control Panel T E. ) CapSense 5. ¥ 24 Ml mik T B 1 E4E
B, &% AN2397, “CapSense®Hii&E TA” .

7.8.1 INFMrEE ) R T A

1. ffH 12USB #r##&#/MiniProg3 #1 USB A % Mini B Z444 1 i U H2 31 CY3280-20x66 UCC HIERHR Y] ISSP
P45 33 I

2. fEHMREE EF, Mk Start > All Programs > Cypress > Bridge Control Panel (/%#) > Bridge Control
Panel (kA .
Bridge Control Panel /&7E PSoC Programmer %23 i 4 i 223 (il — AN 4

3. MR R O PR R

4. H CY3280-20x66 CapSense il # HLE AR F2 4L 5 V 1 HLJE
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7£ Bridge Control Panel &

- mEL BCcp. iic X

. Hiidi OK, IREIF|FE .

7-3. Bridge Control Panel ¥

i /% Bridge Control Panel

File  Editor  Chart

Execute  Tools  Help

FRERE SRR CEEBEERE

CapSense®4# il 4G 7R 7]
HWHH, KIKEFE File > Open. MAIERHIT H S JH11f) BCP Configuration files 3¢

KIKiL#E Charts > Variable Settings. MATE7R4151 B SC#F 41 BCP Configuration files SC#EJ %k BCP. ini

Editor | Chart | Table | Fie |

ER
JSensoxr# =
JSensoxr# =

-

w 04 00 00 ;

|~

JT2C Write <Flave Address> <0ffset> <SensorIndex = Sensor#s=
;Sensor# = 00 for BTWHOD

04 For BIT#H4
05 for SLDHO

;Sensor# = 0F for SLDHD
I2C Write <Slave Address = (4> <0ffset = 0> <SensorIndex

/I2C Read <Slave Address> <Sensor Index, Shits> <Rawlount, 16kits> <Baseline,
R 04 @Sensor Index @1RawCount @0RawCount @lBaseline @0Baseline @1DiffCount EO0Dif:

1e,

152

Successfully

Connected to Bridge/0000011

USBZ2IIC Bridge version 1.22

|

=

. Pawer Protocol

— Send all strings: Connected [2C/5PI-USE converters:
[@Heset ] fg -Ligt ] ﬁSe d o @ 50V @ 12C
Hepeat count: O 433 cpl

EStop Wﬁepeat i—-ﬁ o file Semn peiEe), s

o

| 1:1 | Synkax : OK

Jok [ Cannected 1 I Rowsred 1 volkage: -

7.8.2 iZHUBTNO i aaTHEL. FEMEL AT EM

7. Ki%1PC 5484 W 04 00 00 —X.

8. | Repeat %4,

R 04 @Sensor Index @l1RawCount @ORawCount @1Baseline @OBaseline Q@1DiffCount

PUESERIELLT 12C B4R 4

@ODiffCount @ButtonStatus @SliderPosition

9. fuifi Chart (%) iR, LIAH BTNO IS H. HfELAIFHOE(.
7.8.3 LLHL SLDO MyJEARTHE. HerfEsk. THEEEME &AL E

1. Ki%1°C 5484 W 04 00 05 — K.

2. 1%F Repeat 1%,

PUESERIZLLT 12C B4R 4

R 04 @Sensor Index @lRawCount @ORawCount @lBaseline @OBaseline @1DiffCount
@ODiffCount @ButtonStatus @SliderPosition

3. xiili Chart ki, &% SLDO HJRaATHE. Skl THEEENE %A E
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7.9 A CSD A PR
FEAT Y, FRATH IR T AR B R e F P ) 5 A S 20
CapSense W it{87 .

I
!||
O

CapSense®z il 4+ Cig R~ 1

TTHAR. BLZEHAER, B350 CY8C20xx6A

7-4. R CSD [ i H AR
High-Level API

Hardware
Parameters Parameters
| | \
Set Shield <
acaergi[r:;(is r?:e[ ds Measure C, of sensors

of design using tﬁ;dgoglf;n;me 7 @ Revise PCB design > Set Fingoer Th(eshold

according to AN2292 and to 75% of signal

i AN2318 i
If max C, <45 pF set A

Set Noise Threshold

to 40% of signal

No

Idac Range to 4X.
Otherwise set to 8X.

:

Enable Autocalibration

.

Yes i

Set BaselineUpdate
Threshold to double
the Noise Threshold

I

Set Sensors
Autoreset according to

Yes

Is SNR from all
sensors > 5:1?

Does scan time meet
design requirements?

Set Precharge Source to
A
e Increase Resolution and/or ds of desi
L experiment with Scanning neeas of design
Speed until optimal SNR is i
Set Prescaler according to obtained > _
Table 4-2 of CYBC20xx6A A Set *:YS‘GT?S'S to
CapSense Design Guide No 15% ols'gn"’“

Set Resolution Set Debounce
according to Figure 4-5 and Is SNR from all Yes according to needs of
Table 4-3 of CY8C20xx6A sensors > 5:1? design

CapSense Design Guide ¢
4
. Set Negative Noise
Set Scanning Speed to Reduce Resolution or Threshgold i
Fast D — use faster Scanning el & Nt
Establish digital Speed Threshold
communication interface and i
Set PRS Resoluton o obtinfaw counts fom each
12 bits if scan time > L g 1ing Set Low Baseline
380 therwi t activation cycle, for example. Reset to 10
kS, 08 Et”""se Sl Figure 4-6 CY8C20xx6A
i CapSense Design Guide

7.9.1 BiE CSD UM K E
{#/ PSoC Designer T H, %ML TZE KA CSD UM S3(ix & :

1. ATEREWEN. Fik, 7% ShieldElectrodeOut 3% &5 None.
x 72 BT A 3 (/] CYSC20xX6A CapSense /277 14 AL 1T ] 75 ) 3543 7 it

2. il "
PAFIE RS Cro T HIA LR Cr(HIFMCT 45 pF, [EILiFK IDAC JEH R E N 4X.
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CapSense®z il 4+ Cig R~ 1
x 7-2. AT Cr A

TERBRT 5| B (073
BTNO P1[6] 16 pF
BTN1 P1[3] 14 pF
BTN2 P3[3] 13 pF
BTN3 P2[1] 12 pF
BTN4 P2[3] 11 pF
SLDO P1[4] 14 pF
SLD1 PO[6] 15 pF
SLD2 PO[4] 14 pF
SLD3 PO[2] 14 pF
SLD4 P2[6] 13 pF
SLD5 P2[4] 12 pF
SLD6 P2[2] 12 pF
SLD7 P2[0] 12 pF
SLD8 P3[2] 11 pF
SLD9 P3[0] 11 pF

3. fdift AutoCalibration (HZEIKHE) 3.

4. ¥ Precharge Ji¥% E N PRS.

PRS VR A FE ALY SATHRAE,  FHRATRXS A1 R = YRR A R4 1 s 1k

5. IR¥EATE LSRR CeHRE Prescaler (FUMAY) o« BT RATH ARSI CefEm KN 16 pF, FwR il
SIARASME BN 4.

BEZAHXGEE, 1S CSD UM HdE FAt ) “H-F i, IMO Fl CP 1T Miss k& ” 4K,

6. WR-ATEMHTARE Co ML, IMAERE Co EEKMLRIE R ENFR. AR REIT, HK Ce
5 16 pF, FH Cf KT 0.2pF. % CSD UM #l FMthitE “ & FE 5% EEEMEBAARE AN T HE
(CP) 7 Mk “HEFFIHRARMCP MR EE” , BoRiEEN 13,

7. ¥ Scan speed % & A Fast.

8. FAHWIAIKT 380 pus. % CSD UM Hdls Tt sh i 5T 45 H 3 R4 08B 1) AR IR SR I T 18] (R oy
us) 7 FIFK, WEME N 720 us, [RILAH PRS Resolution BEE A 8 L.

9. X 7-3%IHT Bridge Control Panel FWI%E|A FfL AR (B RIGTHEEE FHe Al s AfES
(FHRMIRD) [1H .

RT1-3. rafe e s

T e Pl s w5 R
BTNO 7072 24 260 11
BTN1 7017 22 280 13
BTN2 7103 24 280 12
BTN3 7275 22 340 15
BTN4 6953 20 360 18
SLDO 6627 26 165 6
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il
iy
)
2
=
1%

EREER . CapSense®z il #34 % 7~ 4
LTS flcpirithy By RS RSB
SLD1 7071 24 150 6
SLD2 6697 24 150 6
SLD3 6505 24 145 6
SLD4 6028 22 160 7
SLD5 5840 28 155 5
SLD6 5687 26 160 6
SLD7 5598 24 150 6
SLDS8 5362 24 150 6
SLD9 5110 30 160 5

10. HTHAEEEK SNR #21ATF 5:1, BN MO RSB, FHEMEESME LED TIIJOL, Ftfn] BHZRE 7-
4 PRARREBESH.
FRATHRAE I A R AR A RIS SEAC B B . R, AR5 S E 5 145,

% 7-4. CSD UM =55k

BESH HEFME HE UM SHiRE
FHRBMAE 55 E M 75% 108.75 108
e 7 1) L &5 HT 40% 58 58
5 25 55 A 2+ ) 116 116
0 75 A g 75 1) (. 58 58
PSS S5 15% 21.75 21

11, BFEE R R R, I HEE BBUEEM ERR Y, e Low Baseline Reset (REELE N S8
BN 10. ¥ Debounce (£$3)) ZHEEN 3.
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CapSense il #& H-15 I S 4 FL B R AR
CSD

e
CYPRESS

Embedded in Tomorrow”

8.1 WHAZMK

CE_8_TuningCSD_withCY8C21x34/B

8.2 Mid

ZAS R U T ey CY8C21x34/B #41iK: CSD F P (UMD . ZiA CapSense UM, #4472 fgs LA T
& #AFH CapSense #ii. ZRIGRPIMEMT EzI2C UM, JRHEI—A 12C BLA—A 12USB i KA 5T 7 1)
CapSense Z¥. ‘E{#H 7 PC L] Bridge Control Panel # -k & & $if .

8.3 MWHRE
8.3.1 Fk

m  CVY3280-21x34 j#H CapSense il #% FL AR

m  CY3280-SLM ifi[i] CapSense £ i 415tk

= CY3240-12USB #r#4 8¢ CY8CKIT-002 Miniprog3

m  CY3217-MiniProgl 4228 £ {+8 CY8CKIT-002 Miniprog3
m  USB A Mini B ki

®m  E173EA Windows XP B HE AN PC

8.3.2 fHE

8-1 W/n TRk E 7. CY3280-21x34 UCC E it 22x2_RA_Receptacle iE#: % CY3280-SLM.
MiniProg1/Miniprog3 B 12USB #i{# #s %3 21845 ISSP i L. % B/ MiniProgl/Miniprog3 #4748, A
FH 12USB Hrid&/Miniprog3 K £ Kk ik 25 PC. B Ti@E USB MZ5iEH:E PC L.
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Embedded in Tomorrow” CapSense®}'§?ElJ%§1”€ﬁE§i<1§lJ
Pl 8-1. M it EAME ]

—»[ MiniProg1/MiniProg3 ]—

[

CY3280SLM H CY3280-21x34 UCC }

—{CY3240 I2USB/MiniProg3]—

8.3.3 ZAAEHIEAIK
5 B A7 DA I

EHE CY3280-SLM T-E 4 i J1 Al CY3280-21x34 UCC HLEHR _E 1) 22x2_RA_Receptacle (GRS P2) .

EAEPE J7 _EE — ke, LUK UCC R RIS 5 V #1 VCC_PROG 4545 . ZiXE o EiEd ISSP # 4
4 CapSense =il 28t .

EAGEE 34 EICE —ANBRER SR, % UCC HLEBHSI I XRES A XRES/INT (51 1 1 2) 4. kB
CapSense =il #%1 XRES 5| IR E ISSP 845 I3 15110 3 k.

TEFGRE J2 L E — AN BhZR4%, 1 CY3280-SLM H AR5 GND A1 SHIELD (518 2 F1 3) k84, @idizikE,

T CY3280-SLM HEEE AR b B kA% B2t

¥ MiniProgl/MiniProg3 H#4#:3| UCC HEEIRIY ISSP i) I3 o KA 7Skl SOk =4 rAR k42 uCC
I, A%, i) Bridge Control Panel #{}iil CapSense ¥i#iit, E i/ 12USB Hi#:2:/MiniProg3
KA E: MiniProg1/MiniProg3 3HT % #

i f} USB A % Mini B £453k 5 MiniProgl (% I2USB #48%/MiniProg3) 5 — 5.
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8.4 JRILMK

1k

3

BO P1[6
B1 P1[3
B2 P3[3
B3 P2[1
PO[0] R2 52
B4 P2[3 FO[1] 560
Rb Cmod PO[2] R6 53
P3[1] RE. \ ~L5K PO[3) R A pm ~560 4
- 0[4 R1L 560 54
CAPSENSE BUTTON c2 Polst 250 E
= PO[6] R16 55
3.9nF  PO[7] R18 560 2
‘= 560
css1 P 20 4
22 56
23 560 4
o Pl4 25 56
27 56
NN P 560 7
1 PO[6] P2[6] R29 51
P27 =’ 560 6
| 2 Po[4] Active Low Configuration
Output
3 PO[2] HCLK R32m 42
TCIK R3Y = VI 23
AN GCD0 R V1o 15
4 P2[6] OCDE CE AW 14
0
5 P24 smp 16
XRES R37,% 41
XBES  RIAA——EL ]
16 P22] 100
| 7 _P2lo] CY8C21x34/B
I Jo]]  CYBC21xx34
| 8 P3[2] [
CY8C21xx34 CAPSENSE
9 P3[0] CONTROLLER BLOCK
SLIDER SEGMENT

P32 (Cwmop) 27t PO[3]5] I EIEFL I K/INA 2.2 nF A . fEH—1 560 Q BJHFLK %4> CapSense i &
BRER, DARRRS T4, K LED FEE MR AR, JPRESE A 1kQ K. ZE#EPIE I LED. K
ANHSE LS — M 10 AN aT HTBLRITE 2%

#* 8-1. LED. F#BERIVEHAI 5] 5 Hd

LED bt R

LEDO - P2[5] | BTNO - P1[6] SLDO - P1[4]. SLD1 - PO[6]

LED1 - P2[7] BTN1 - P1[3] SLD2 - PO[4]. SLD3 - P0O[2]

LED2 - PO[1] BTN2 - P3[3] SLD4 - P2[6]. SLD5 - P2[4]

LED3-PO[5] | BTN3-P2[1] SLD6 - P2[2]. SLD7 - P2[0]

LEDA4 - P1[2] BTN4 - P2[3] SLD8 - P3[2]. SLD9 - P3[0]

8.5 HWAWE

8.5.1 HEHTH

m  PSoC® Designer (JiA 5.2 8L & RAD

®  PSoC Programmer (A< 3.13 B8 & ilA)
m  Bridge Control Panel (iR
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8.5.2 H PR E
TRIUH T AR B R 0 R P B DA% AN FR 0 BB B o R (B 5 R«

P JHE
CSD CapSense fiit, Ehf 4 1 (BRI
EzI2C I2C/SPI itk

8.5.3 PSS . &R
T H [ty ReadMe.txt SCEF3 B T 1% A0 5 9 ob B A O P BB [ S 50 B . A, BIR R T — A4 R BRI

R WO ZARREIT TR, 2554 CY3280-SLM EfFH 1.5 mm JEW 5 /) o6 2 . BRG] AT R
B R AR R B, 35 4% ARG 2] T Bl 1) P 7 TR AL

8.6 #HAEULH

AL, R AT LR A

5E X MyI2C_Regs G5t fk, UIAAEIcsgn s G THE. THECEME . BHEL . FoO A B DL e R g B AR Y
ff) CapSense &8 (R4

R4 bk, SR)5 3 CSD UM ik,

JA3) EzI2Cs UM, #AJ5%% Myl2C_Regs &5 /&5 E N 1°C RAM 21X .

m EPRIEF AT T HR AT

o FREEFRPTA AR IREE, IF N MyI2C_Regs SRR AGTEEG. THECEE, FAMELR. WSO AL E DUk E
CapSense 148 FPIRES . B 88 S 5 5 AF) EzI2C Wi 12C 2o XIS — A7, 12€ 7] DB SR EEA

552 #48 Y) CapSense i

o CYEPFIBZ AR, E RN LED AREVI#ON “ON” o BiULin, LED RE2VIHN “OFF” .

o BT, B2 LED BRSO “ON” . DIFORBA E .
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K 8-2. ittt 8 IZhREHiRE

4

Enable Global Scan All Sensors
interrupts Update all baselines

v v

Check for active
sensors

Set 12C RAM buffer

4

Update LEDs
Start 12C

Start CSD UM ¢

Update 12C RAM buffer with
CapSense parameters
(RawCount, Baseline, SensorMask,
Difference Counts, Slider Position)

A
A. Initialize CapSense
baselines
B. Set Finger
thresholds

8.7 BATAREHI

o I H R S A FER AR, SRR IR P AT AU s Bl . A R g fE UCC BB PEAR(S S, 152 L CY3280-
21x34 EHEE SR TLE .

1.
2.

i F MiniProg1/MiniProg3 5% CY3280-21x34 UCC B AN AR 1% R AR 2 At 5 V (1 F iR
i3 CY3280-SLM B FLERAR |- AL 2%
CY3280-SLM H R FAHR 1) LED £ fi5%.

R
CY3280-SLM b AL B _EAHN ) LED 2% s, H] LA b2 A b o] DA P ek i A R 42«

8.8 &L I°C Bl CapSense ¥

WA P BATAAG R, JH2EX Bridge Control Panel T E. L [¥) CapSense $4E. T 24 =M% Hil AR T B i 4
fE8., {553 AN2397 — CapSense®HE & HE T A..

8.8.1 Jn#EktriEE AR T A

1.

f#FH 12USB Mi#% #:/MiniProg3 #il USB A % Mini B k45, K& HHEHLIER: S CY3280-21x34 jfi ] CapSense 1%
il 2% FEL AR A 1ISSP iR R 33 L

7E RN S b, Rk Start > All Programs > Cypress > Bridge Control Panel (/#&#) > Bridge Control
Panel (&k#A) .

Bridge Control Panel /&7E PSoC Programmer %23 i 4 i 23 (il — AN 4

Mg 11 e 7 P e B T A
4 CY3280-21x34 CapSense %l 2% HLEE AR 5 V 1 HLIE.
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Embedded in Tomorrow™ Capsense(@%%u%%ﬁﬁg%%

7t Bridge Control Panel & HH, {KiIxEF File > Open. MARRG R H SCAF3 ¥ BCP Configuration files S

Fplin#k BCcp.iic X,
KIKiL#E Charts > Variable Settings. MATE7R4151 B SC#F 41 BCP Configuration files SC#EJ %k BCP. ini

. Bl OK LUR[EI .

o

o

i E Bridge Control Panel

Fle Editor Chart  Execute  Tools  Help
FEE SRR E | EEE

Edior | Chart | Table | Fie |

;IZC_Write «Slave Address> <0ffset> <SensorIndex = Sensor#r
JEensor# = 00 for BINHO
;Sensor# = (04 for BIN#HL
;Sensor# = 05 for SLD#HO

JEensor# = OF for SLD#HS
W 04 00 00 ; I2C Write <Slave Address = 04> <0ffzet = 0> <SensorIndex = 0>

;JI2C _Read <Slave Address> «<Sensor Index, fhits> «<Rawlount, 1bbits> <Baseline, 16
R 04 @Sensor Index @lRawCount @0RawCount @lBaseline @0Baseline @1DiffCount @0Dif:

[~
|~

>

Successfully Connected to Bridge/0000011
USB2IIC Bridge wersion 1.22

=

. Power Pratacol

Send all strings: Connected [I2C/SPI-USE corwerters:

l B Resst ] ?S List ﬁSend Heneat counf o @ & 5.0V ® 12c
5 SRl

[=]ston @Hepeal D file: S peiad, ms )

[t T sntax ok Jok [ Conmected 1 [ Pawered 1] valage: -

8.8.2 iZHX BTNO MJEidatHE. FEMELATHEEM
1. Ki%1PC 5 A4 W 04 00 00 —iX.
2. 1%F Repeat 1%, HLLKRIZLLT 12C 5484

R 04 @Sensor_Index @1RawCount @ORawCount @1Baseline @0OBaseline @1DiffCount
@ODiffCount @ButtonStatus @SliderPosition

3. %) Chart i, LWATEEIGTE. SEMELA BTNO (¥ M.
8.8.3 iHU SLDO HyJRAa 114, FEuEL . 1= EAE &1 E

1. Ki%1°C 5484 W 04 00 05 — K.
2. P F Repeat %48, H4EKIELLF 12CEiE4

R 04 @Sensor Index @lRawCount @ORawCount @1lBaseline @OBaseline @1DiffCount
@O0DiffCount @ButtonStatus @€SliderPosition

3. xiii Chart &b, DIEEFA SLDO fAATHE. FEAEL. tHEOR M %A B
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8.9 AR CSD F ik
Z i, CY8C21x34/B

FEAT T, AT BN R AR B R PR B AN ST TR EEEE R, 155
CapSense i1/

Begin

Y

Setup Hardware and Software

Water Tolerance Required

iYes

Shield Electrode Out = Enabled
Route shield electrode to pin No

Reference = ASE11
L
Ref Value = 2

'

Select Prescaler if using a
configuration with prescaler

Increasing Rb increaces

‘ Raw Count

Raw Counts = 60-70% Max j
Yes
Increasing Resolution and
No»| decreasing Scan Speed
increases SNR
Yes

‘ Set High-Level Parameters ‘

A
End

8.9.1 M#E CSD UM ¥ &
{#iH PSoC Designer 1B 3% 88 DL B IREATEME, S2BIXT CSD UM S0 B T NAC & -

ARG~ F ] 7 Rb = 15 kQ 1 Cmop = 10 nF. CY3280-21x34 UCC MM H T —MEEM Rb . FEHE

1. =
XE’\J RLESAR B, 0T LUl & ek Rb B SR IR P s
Z ), CY8C21x34/B CapSense Wil TRH I 4.2.3 =11, T AEWFTES: R, MM CapSense f& 8 # i RS et
2. AFEEFEMABENK. Hik, 7% ShieldElectrodeOut %% B N None.
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%.5 CYPRESS

CapSense®z il 4+ Cig R~ 1

% 8-2 B TAEFH /CAG 15 (fE/1 CY8C21x34/B CapSense 741 #4148 #9465 11 7% ) v A48 B 77 VLI B
IRIFHILIRSS Cro T RATRHBIF CP I KAE N 16 pF, KUK TS B E N 4.

% 8-2. Ak I&As1 Ce

TR 5 Ce

BTNO P1[6] 16 pF
BTN1 P1[3] 14 pF
BTN2 P3[3] 13 pF
BTN3 P2[1] 12 pF
BTN4 P2[3] 11 pF
SLDO P1[4] 14 pF
SLD1 PO[6] 15 pF
SLD2 PO[4] 14 pF
SLD3 PO[2] 14 pF
SLD4 P2[6] 13 pF
SLD5 P2[4] 12 pF
SLD6 P2[2] 12 pF
SLD7 P2[0] 12 pF
SLDS8 P3[2] 11 pF
SLD9 P3[0] 11 pF

3. ¥ Precharge Source % & N PRS.
PRS VRRES SIS BRAE,  FEIRORAS S0 75 s it R4 1 S

4. MHAEITARREEERK Co R E Prescaler (Fsr4ids) o HTIRATNZRGIH, &KX CelEN 16 pF, KLAH#
o SR BN 4.
WEHRAFL, HS W CSD UM Hdli Tty “HETHirm i, IMO F1 CP T Fiat & ” 5%k,

5 WMPE—AWMEMHT AR Ce MRS, MATHERE Co R KR EESHER, ERINTREIF, BK Cp
% 16 pF, H Cf KT 0.2pF. % CSD UM HdlEF/ R Bl “ILT-78 55 2 )5 BE AR T AR A8 BRI =4 A
(CP) 7 fik “HT FIRHAM CP Wi E” , ¥oayisgikiE )l 13.

6. 1&#F Comparator (W) , WHESERH ASELL,
ERZESHE T, EE#H ASELL.

7. % Scan speed % & Normal.
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CapSense®z il 4+ Cig R~ 1

7% 8-3 %t T Bridge Control Panel (Hfrefzilmit) SR A R A rme S (R aG T E7E TE TR s
WA AES CRIRmED HIMHE.

% 8-3. Tt A IE S

rewm | RENS | #E | % | s
BTNO 4451 179 20 9
BTN1 3921 182 20 9
BTN2 3419 184 21 9
BTN3 3186 179 20 9
BTN4 2652 191 21 9
SLDO 3790 100 20 5
SLD1 4432 101 20 5
SLD2 4026 101 19 5
SLD3 4011 103 19 5
SLD4 3739 107 20 5
SLD5 3456 104 20 5
SLD6 3310 110 21 5
SLD7 3158 99 19 5
SLD8 2900 101 19 5
SLD9 2688 115 20 5

8. MTHrAMLEIK SNR HAT 5:1, HAMMNECE LWL, TIRMERWEA LED SZIADY, EAR LUz L
8-4 hHIfE R EBESH.
FRATHRE T o AR (B R N5 SR B RE . L, FERAIMRG 5 5{E R 99

% 8-4. CSD UM = 253

RESH HERFE B UM SHRE
FHRBME 155 1HN 75% 75.3 74
e 75 ) i 55 {E K 40% 39.6 40
e i 2R T I 1E 218 75 80 80
e 75 B e 75 ) 1 40 40
IR B 1H1 15% 14.9 15

9. HTHIR AR ER, FHEAE BRI EWRIRT, FAk Low Baseline Reset (fREMELREN) S5k
N 10. ¥ Debounce (E# &) HEEN 3.
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RIG7RH1 9 1] CY8C20x34 CapSense

FEH 22 R CSA_EMC

o

' CYPRESS

Embedded in Tomorrow”

J

!|| .

9.1 WHAZK

CE_9_TuningCSAEMC_withCY8C20x34

9.2 Mid

ARG R IV T A0y CY8C20x34 44 CSA_EMC I #iH: (UMD . Zifif CapSense UM, fEnZifeis s
EEIEMH RN CapSense #fE. ZCHRFIfliH EzI2C UM FHiliid 12C SLEM 12C K AT CapSense S¥tLsh
USB #3588, E{fif] 7 PC L Bridge Control Panel #3525 & $45 .

9.3 WHRE
9.3.1 Mg

m  CVY3280-20x34 ifi[T] CapSense {2 fill 8% B A

m  CY3280-SLM ifi[i] CapSense £ i 415tk

= CY3240-12USB #r#4 8¢ CY8CKIT-002 Miniprog3

m  CY3217-MiniProgl 4228 £ {+8 CY8CKIT-002 Miniprog3
m  USB A # Mini B ki

®m 7H USB i H 1 PC

9.3.2 fHE

9-1 B Rk E . CY3280-20x34 UCC Efid it 22x2_RA_Receptacle iE#: %] CY3280-SLM.
MiniProg1/Miniprog3 = 12USB #i{# #s %3 218451 ISSP i L, % B/ MiniProgl/Miniprog3 #4748, FH1d
FH 12USB Hrizd8/Miniprog3 ¥ £t ik 28 PC. {# [ USB 8 B 1i&E#:E] PC L.

Pl 9-1. i it EAMER

—»[ MiniProg1/MiniProg3 ]—
[ CY3280SLM H CY3280-20x34 UCC ]—
—{CY324O I2USB/MiniProgS]—
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YPRESS
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9.3.3 ZHIEH R
AT LR I

1
Wy
)

CapSense®z il 4+ Cig R~ 1

m 4 CY3280-SLM T RAgHEEE J1 #H5] CY3280-20x34 UCC HLEEHR 1] 22x2_RA_Receptacle &R P2) L.

m TEHEE I BJRCE —MBkREE, LUK UCC HERAR MBI Ve F1 5 V AHE:. 1ZI B A VFEIE ISSP HE a4
CapSense il # L H

o TEREE J4 BJE —ANBRZRER, K UCC RIS XRES R XRES/INT (51 1 f1 20 F#H:. ZREH
CapSense il ## 11 XRES 5| &2 ISSP &4z I3 1151 3.

W TEHREE 32 FJHCE —MBRRER, K CY3280-SLM HLEEH YIS GND A1 SHIELD (51 2 F1 3) #0#:. @l i%ikE,
Al¥ CY3280-SLM HLEHR L (1 R kS F22 3

= ¥ MiniProgl/MiniProg3 Z4#:%| UCC HESHR AT ISSP i) J3 L. R 7Skl 0= RIS R gmfE UCC
I, A%, [/ Bridge Control Panel #{}iil CapSense i#it, E M/ 12USB Hi#:2:/MiniProg3
% MiniProgl/MiniProg3 #E4Ti%E 4.

m  f#f] USB A % Mini B ££45 4 MiniProgl/Miniprog3 (B I2USB %83 1% —ii%E#H| PC L.

9.4 EFEHE

B0 @ P1[6;
® T
81 (@)— Pl
B2 i P3[3 o1
10 uFd 25v
B3 @ P2[1
g
B4 . P2[3 U1
PO[0] R1 34 o 0 R2 0
O[] R3_\pmA560 2 | PO S PUO "5 Rs vw\/sso
0[2] R 560 35 | POIL PI 51 Re 560
CAPSENSE BUTTON 5 pm 560 35 | 560
Cmod R 560 26 ggg gi% 5 RE L\ pm 560
Ol RO /560 36 |
RO AI80 36 4, p1[a] 2RI A\ Jm 360
c2 0 T\ A560 Z Pl 10 R12 560 .
0| R
oo PO RIS S0 4a] POIS PLIE] [5* R s 260 T
: Yo PO[7 P1[7] e KK
=’ 560 = 560 P2[5] D6 RA40 1K
css1 ™
R 30 28 R19 P3[0
P2[0] P3[0] 51 T P2[7, RR
R /,.\5{&0 6] P20 ral [ 1 g 560 2 pg RK| RAL A A K
0 PUA R 0 3L pop2 pa2] [F22—RZ A Jm 560 2
R 0 5 7 5 560 P33
P2[3 P3(3] ANIRAZZ PO[1, K d
VAN L s T : g 3‘2’ pa ‘= 560 D7 ‘ R38 \ A ALK
P2e] R 0 33 | P2I5) 27 R29,™, XRES
AN P2[7] R ,.\sﬁo 3 Egs XRES 100 PO[5] D9 RK R39 1K
2 PO[4] ‘=560 1
NC X
11
AV mg 2% PO[7] D10 RX R42 1K
PO[2] 5
. HCLK  R32= ECH mg ﬁ 3;::
ZAVAN TCCIK R35 ™10 18] BCik NG 2% Active Low Configuration
4__P2[6] OCDO___Ra4,™ V10 4 23
= Output
X P
GCDE __R2 10 25 OCDO NC |55
AN 1o OCDE NC [H53—X
s po) NC [2e—X
NC 5%
NC P2
o 6 P2[2] 893 Mo
222 CY8C20434
ZAVAN 4 P nJela]  CvBC204:-
| 7 P2[0] O
L\ L |  cvscooxx3a capsense
|8 P3[2] CONTROLLER BLOCK
NN AV
9 P30
SLIDER SEGMENT

AR (Cvop) 2 MEHKE PO[3]HY 2.2 nF A/MHA . {#H]—1> 560 Q MHFHLHE %> CapSense %4 ik
R, UIRERGTTHt. 5 LED RCENRAETAR, JREHAE D 1kQ WM. ZEEEP A A LED. IiAp
RS — M 10 AN AT B %
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EREER . CapSense®f% il g A Uit 7= 1]
% 9-1. LED. 4ZE AN HL 5] 5T
LED i35 by 28

LEDO - P2[5] | BTNO - P1[6] SLDO - P1[4]. SLD1 - PO[6]

LED1-P2[7] | BTN1-P1[3] SLD2 - PO[4]. SLD3 - PO[2]

LED2-PO[1] | BTN2-P3[3] | SLD4-P2[6]. SLD5 - P2[4]

LED3-PO[5] | BTN3-P2[1] SLD6 - P2[2]. SLD7 - P2[0]

LED4 - P1[2] | BTN4-P2[3] SLDS - P3[2]. SLD9 - P3[0]

9.5 HHRE

9.5.1 FHERLTH

m  PSoCP® Designer (A 5.2 85 =R A)

m  PSoC Programmer (JRAS 3.13 B3 @A)
®  Bridge Control Panel ({7 iR

9.5.2 H itz %
T T 27 1 b T P F AR D %A P PR T o P F A

F sk BEAEHR
CSA_EMC CapSense
EzI2C 12C 5Bt

9.5.3 HIBIRZSEL. 4R BHK
5 F 1) ReadMe. txt SCHFHEH] T % ARESR BIh AL IO AP BERIO S RO . IAb, B T — AR B A,

R ATHZARED BT TR, 2 4 CY3280-SLM £ 1.5 mm BRI & &2 . B EH A G R
B i R AR R B, 35 4% % ARG 2] T B 1) P 7 TR AL

9.6 HAEULEA
SO, [T DU RAE:
mE NG MyI2C_Regs, UMEEIEEEGR T RIGTIEL VHECEE. AL, OO0 E LR G B IR g S AR
M) CapSense #8R7 .
m FHARFW, SAJEE3 CSA_EMC UM,
®m  JHZ) EzI2Cs UM, #RJ5¥ Myl2C_Regs MR E N 12C RAM 254 [X .
m CPRIEMHIAAT T RAE
o FREEATE LAY, N Myl2C_Regs SRR R TIE. THEUEME . B, B &P O E LUGE E
CapSense B HPIRAS . B 1845 5 A\ 3] EzI2C W& 12C M XIS — A5, 12C AT LR IEA
52 #48Y) CapSense Hif .
o CYEAR B AT, BN LED IRE VI “ON” o BRGNS, LED RESVIHN “OFF” .
o AN, EASK LED FRIREDIHN “ON” , UIFRoRfit B E .
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K 9-2. AU ] 9 HI DI REVRE

Start Loop forever >4——

4

'!!!!ﬂ!!“‘

Eqable global Scan all sensors
interrupts Update all baselines

v v

Check for active
sensors

Set I°C RAM buffer

4

Update LEDs

Start I°C
Start CSA_EMC UM ¢
v Update 1°C RAM buffer with
A. Initialize CapSense CapSense parameters
baselines (RawCount, Baseline, SensorMask,
B. Set Finger Difference Counts, Slider Position)
thresholds

9.7 BATARE I

R E K AR BRI, AR5 R AT A R ). A Rl g2 UCC MBS FEANE S, 2% CY3280-
20x34 BAF4E 8 LB 1Y
1. f##H MiniProgl/MiniProg3 5 CY3280-20x34 UCC £ {5 Fr /- R ARSI AR B2 it 5 V T HLIR
2. fili CY3280-SLM LR AR _E 2RIt iE 5% .
CY3280-SLM H %R FAHRP) LED £ fi5%.

3. FREIEANERE.
CY3280-SLM b AL B _EAHN ) LED 2% s, H] LA b2 A b o] DA P ek i A R 42«

9.8 &L I°C B CapSense ¥

$ W% AR FF AT ARG 2R 45 312X Bridge Control Panel T E. ) CapSense 5. ¥ 24 Ml mik T B 1 E4E
B, &% AN2397, “CapSense®Hii&E TA” .

1. #RLAEA 12USB kst MiniProg3 1 USB A # Mini B 245, AT LUK ESRIHHENLIER:E] CY3280-20x34 i ]
CapSense % il 25 AR 1) ISSP i&4#:48 33 L.

2. fEHMGREE F, ki Start > All Programs > Cypress > Bridge Control Panel (/7> > Bridge Control
Panel (&#A) .
Bridge Control Panel /&7E PSoC Programmer %23 i 4 i 223 (il — AN 4

3. MR CHEREE ORI T B AR

4. 4 CY3280-20x34 CapSense % il 2% HLEEBAR (L 5 V [ HLIE .

5. £ Bridge Control Panel & 91, # ki File > Open. MALHSR{FI3H H 43 7] BCP Configuration files 3
P In# BCP.jic 3.
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WK% Charts > Variable Settings. ML= H {3 #1f) BCP Configuration files 332 m#k BCP.ini
. Hiil OK, IR EE .

i3 Bridge Control Panel

File  Editor Chart Execute  Tools  Help
s H SRR CEEEE

Edtor | Chert | Table | File |

JIZC Write <Slave Addresss <0ffset> <SensorIndex = Sensorfs
;Sensor# = 00 for BTWHO

;Eensor# = 04 for BIT#HL
sEensor# = 05 for SLDHOD

;Sensor# = OFE for SLDHS
W 04 00 00 ; T2¢ Write <S5lave Address = (d» <0ffset = (> <FensorIndex = 0>

sIZC Read <S5lave Address> <Sensor Index, Skits> <RawCount, 1ébits> <Baseline, 1a.
R 04 @Sensor_TIndex E@1RawCount @0RawCount @1Baseline @0Baseline @1DiffCount @0Dif

2

<3

>

Successfully Connected to Bridge/0000011
USBZ2ITIC Bridge versiom 1.22

1=

Frotacal

Power
[ ®Heset ][_-;:LISI ]LSEI’]d ] Send all stings: [] Cannected 12C/SPI-USE converters: E G 450V 5 e
e ] e
[=dstop Wﬂepeat D file Sean period, ms: ,—UC|

I 101 | synkax: ok Jok

9.8.1 BEHU BTNO By THE. FEHELR AT A Z(E

3.

Ki% 12C 5454 W 04 00 00 —¥X.
1% F Repeat %488, HE8RIELLT 1°C 5464

R 04 @Sensor Index @lRawCount @ORawCount @lBaseline @OBaseline @1DiffCount
@0DiffCount @ButtonStatus @SliderPosition

i Chart @Ik, PAEH BTNO R THEL, FEMEL AT E .

9.8.2 iZHL SLDO HyJRIA ¥, FeuELk., i EEAE &I E

1.
2.

Ki% 12C 5454 W 04 00 05 —¥X.
1% F Repeat %488, HZRIELLT 1°C 54654

R 04 @Sensor Index @lRawCount @ORawCount @lBaseline @OBaseline @1DiffCount
@O0DiffCount @ButtonStatus @SliderPosition

i Chart B3R, A SLDO MJEAATHE. FEAEL. THEBOREMN AL E .
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9.9 YK CSA_EMC F sk
TEATF, FATERACL I RAERS S PR RS, B2 1R4ER, 5% CY8C20x34 CapSense
i

|

Low-Level (Hardware) Parameters High-Level Parameters

Measure Cs of Sensors 4_1 Revise PCB design Set Finger Threshold to
75% of Signal

according to the PCB Layout
Guidelines listed in

Y CapSense Getting Started
Guide Set Noise Threshold to 40%
Set Clock I of Signal
NO +

Set Baseline Update
Thresheld fo double the
Noise Threshold

v

Set Sensor Autoreset

Set Settling Time

Is SNR from all
sensors > 5:1

Y

Monitor CapSense Data ? according to the need of the
(RawCounts, Baseline, - L=
Signal) Increase 5|_gna| I Apply *
Software Filter / Enable
Spread Spectrum / Increase Set Hysteresis to 15% of
Immunity Level Signal
I Y
NO
Set Debounce according to
needs of design
o ~Is SNR from al™_ YES
. sensors = 511 ] *

Set Negative Noise
Threshold to same value as
Noise threshold

Y

Set Low Baseline Reset
according to needs of design
(Recommended value = 10)

Y
End

9.9.1 fid#E CSD UM &
{fH PSoC Designer T2 I #Z 8 DL N B BT EAERALE CSD UM S50k E, HEMAWT:

1. {E PSoC Designer T.Eff] “Global Resources” (&R & HH, ¥ CPU_CLK %4 SysClk/2. MRIEER)&

iR, £ “Global Resources” & Il it B HiAh Sk,
% 9-2 FIH T FEAG5 0] 6 (fE/ CYBC20x34 CapSense 7257l 1% /8 #1926 x0 1 75) Hf 753 R 8 i By
B Co. BITIRAVREIPH KN CofE N 15 pF, H IMO 5y 12 MHz, EH A “Clock” (f4h) HREE

A IMO/4.
FLAH 5 IMO 5 R, i3I CY8C20x34 CapSense ¥ it 3% 15 ATkt M 4.
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% 9-2. At I&as1 CrfH

AR 51l Ce

BTNO P1[6] 15 pF
BTN P1[3] 13 pF
BTN2 P3[3] 12 pF
BTN3 P2[1] 11 pF
BTN4 P2[3] 9 pF
SLDO P1[4] 14 pF
SLD1 PO[6] 14 pF
SLD2 PO[4] 13 pF
SLD3 PO[2] 12 pF
SLD4 P2[6] 12 pF
SLD5 P2[4] 11 pF
SLD6 P2[2] 10 pF
SLD7 P2[0] 10 pF
SLDS P3[2] 10 pF
SLD9 P3[0] 9 pF

fFA T AR “Settling Time”

5 X Ciyp

Settling Time =

<Clock X C, X25 (L)>
Fepy
CINT =39nF

Clock = IMO/4 = 3 MHz
Cp=15 pF

CEALISIRD S

Fcpu = SysCIk/2 = 12 MHz/2 = 6 MHz  (fEiZ 7~ B, ¥ SysClk &N 12 MHz)

XA AN B E AT, WA H: Settling Time = 80
P ETEE, ] Bridge Control Panel il SNR {H. % 9-3 1l T 7EiZACH 7 451 b WL 22 31 48

R 9-3. ME B P A LR HE S

CapSense®z il 4+ Cig R~ 1

wmun | RSN W #% R A
BTNO 2000 14 130 9
BTN1 2140 15 140 9
BTN2 2210 18 140 8
BTN3 2230 16 140 9
BTN4 1930 20 150 7
SLDO 1985 11 100 9
SLD1 2310 14 95 7
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T I s f8% R R
SLD2 2075 14 105 7
SLD3 2160 13 95 7
SLD4 2500 14 100 7
SLD5 2370 15 105 7
SLD6 2200 16 105 7
SLD7 2180 14 110 8
SLD8 1960 14 110 8
SLD9 2050 15 110 7

4. HTHRIKSNR =7 (BEIRZELNELD KT 51, FHA#HEE 94 HESN SRS
* 9-4. UM IR Z S %
BESH HERH HfE UM SHE
FiamE 55 EM 75% 71.25 71
Mt 75 o) =511 40% 38 38
HEEL ST 2 7 R 76 76
e 7 ) L N 7 o) L 38 38
IR =511 15% 14.25 14

5. HAZHLRE N EANIBOAE.
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G715 10 @I Ad ] CY8C20xx6A L[]
SmartSense, A X —> CapSense % it

17 DIAEiAL

Embedded in Tomorrow™

10.1 TiH %K

CE_10_PowerOptimization_withCY8C20xx6A

10.2 HER

ARSI B AR 2 SmartSense ¥ — /MBI DIFER R 50 pA PLTF . iZARIERBIRAH T SmartSense flZ 4~ 16
PrsERT 4% UM BEE 288 40 70 4 i 1) B 9 A T REARASE 20, DAVR/D PR B R . JRATIHS 16 A5 i 21 3 e il 2
{F ], DLTERTEG B HE AR A 8] i i g 281

10.3 TEHKE
10.3.1 AHCHEAE

m  CY3280-20x66 ifi F CapSense {2 ill # Hi 1R

m  CVY3280-BSM i [l CapSense fij 4 itk

m  CY3217-MiniProgl #fE# & 4F8 CY8CKIT-002 Miniprog3
m  USB A # Mini B ki

. AR
" R
10.3.2 IHE

10-1 BoRm 25 E 770, CY3280-20x66 UCC i@t 22x2_RA_Receptacle %#:% CY3280-BSM ik, i%
B T EREREM 1ISSP # K MiniProgl/Miniprog3 #E1T4mFE

10-1. f{F B EHE ]

CY3280SLM }—»{ CY3280-20x66 UCC H MiniProg1/MiniProg3
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10.4 ZH3EHERIR

i AT DL BRI

CapSense®z il 4+ Cig R~ 1

m 4 CY3280-BSM TR J1 #HEE CY3280-20x66 UCC HLEg#R [ ] 22x2_RA_Receptacle GEHERE P2) .
m TEHRAE J7 LCE —AMBRZRER, B UCC HERIR LRIBIB Vee Ml Vee proc 1. ZINE RRUFEIEIT ISSP S48

CapSense il #5LH.

m ERREE J4 LE —AMBEZRSS, B UCC HESRAI S XRES Al XRES/INT (51| 1 A1 2) fEHz.
CapSense #1281 XRES 5| JiEH: 2] ISSP i&EHz88 I3 (1151 3.

ZBEH

RS J2 LE —ABEZRRS, ¥ CY3280-BSM HLESHRIK S GND #1 SHIELD (51 2 #1 3) 4G4%. XFESAE
CY3280-SLM H R - ) kA A Bzt

® O} MiniProgl/MiniProg3 i%#: %] CY3280-20x66 UCC ff] J3 #fifE I,

Emadt
J:__i.i‘nlz
g5 _ | H s
g = | & T
s} [} ) (s} [} (=]
® LI 3| i %‘I T ?I 93[ $| El
S EEEYC S EEEGR
o gl Ff” "5 P2 R P |x.
o e ) 2
. aapy) 20
o pam) Fap [P
S P a2
o—E 1 papgg gy
= e CYRCZORER 4] -
2 v
o—2d eapy |20
010 ey pam o
o0 pgpg) wREs |2
ot wm o o am [P
ERETRNTRE - A -
A T = A A % O a % E A& &
'J‘Slﬂl;?l%?ﬂ 2[2 :131{&[!1
C o C C o C o C o
s
HEE:

CapSensa Button

cap_butd
LED
Ty
LEDMD I
ROt um, E}J

TR ThRER, FEMK CY3280-20x66 i T CapSense %23 ik L) LED D1 1 D2. A

SmartSense UM I3 I ZHFEEL T REiH SNR 1. MR A S HER CapSense A 18RRI S, HLL

DRI
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% 10-1. A7) 10 FI 514

il SIH
Errg ) PO[5]
LED PO[1]
Cwop PO[3]

10.6 #ARE

10.6.1 i HLHE
m  PSoC® Designer (iA 5.2 B8 F A
m  PSoC Programmer (fii4s 3.13 B &4

10.6.2 H P EER%R
T T 27 1 b T P F AR D %A P PR T o P F A

FPBaR TR BEIR P PR
SmartSense CapSense Bk, EHf 4% 1 (BRI SmartSense
TERTEE 16 SERS 2% 0 Scan_Timer

10.6.3 H AR . & R/EIE
T ] 1 ReadMe.txt SCAF 8 T 12 Ao 1 ok 57 A P 1 PR P B ) S M0 B . AL, EIEAREE T — A4 R BRI

10.7 #RAEULHA

SRS, FEFF S G B P P B B BN AR B S, IFHAT main.c. VA, EPRRIAT LU #AE:

m k1l SmartSense UM. ScanRate_Timer UM 1 LED.

m [fREEFT W, SR E3h SmartSense fil ScanRate_Timer i ARk,

m CYEER B A, E AR LED RS Iy “ON” o BSdREN, LED REXVIHN “OFF” . i
R, ATIGIE AR T RE .

B IR NBEAREE, R AR Ak A RS . I BMPIGTE ScanRate_Timer S W7 A MR AR AR 2 A s i

AT AR, FEFE % SCANRATE_TIMER_VALUE. iZ##{Eal L% ScanRate_Timer (I E] . FEARIHEE R, mi
LR E SR
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Start

4

A. Enable global
interrupts
B. Clear LED

Start SmartSense UM

4

Initialize CapSense
baselines

v

Initialize Scan rate timer;
Set the PERIOD value to
achieve desired current

consumption

10.8 PATARIGRHI

I H R g AR R ER AR, ARG IR AT A R Bl . BRIl fE UCC RIS PEAIME S, 12 L CY3280-

20x66 EfFHEH S L E .

1. FEARENEEE, EmERRREIT % SCANRATE_TIMER_VALUE. iX# %% ScanRate_Timer F ik
MSHE . FAEFIRT LT R R:

AR AR = JE I Pk R

b, F# = SCANRATE_TIMER_VALUE
2. (A ERRNESEE 258 250, 500, 750 A1 1000 ms B IE . BT BRI BoR T ANE TAFE B EAA

[FIFHEE AN KD FE.

WWW.Cypress.com

K 10-2. A1) 10 FIThRE R

Loop forever

Scan all sensors
Update all baselines

CapSense®z il 4+ Cig R~ 1

Resume SmartSense
UM

4

Check for active
sensor

Device wake up

Stop SmartSense UM
Enter Sleep Mode

4

Update LED

A
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Pl 10-3. AN [7] 91 473 2 T H S I )P 24 VAR
45 +
40 39.6
4 39.1
40 39
35 -
328 32.4 317
30 - 29.5 29.1 28.8 314 Scan
3 - ——= — 28 —m 27 %
c . 25.4 25.2 ates
- | O —_— .
" 25 —— =® 251 =250
)
& 20 A 500
8 == 750
Q15 -
< ——1000
S
g 10 -
<
5 .
O T T T 1
5V 3.3V 2.4V 1.8V

Operating Voltage in Volts

R 10-2. AN[FIFAF 3 AN RN -7 2 LA

SFIER (UA)
HiEER (ms)
5V 3.3V 2.4V 1.8V
1000 25.7 25.4 25.2 25.1
750 29.5 29.1 28.8 28.7
500 32.8 32.4 31.7 31.4
250 40 39.6 39.1 39
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‘l“lu

L& CSD A Pk

EEMAETH R PRSI E, EBFEE%EE PSoC®Designer ¥ 1[4 CapSense F /R (UMD . BT
BH UM B, &R DL AT E A — B IE R B IMER . FTH CapSense UM #8ELH SBIMAC E R, 78 F M
A, AT — AR 5ok ECE CSD:

1. 7E PSoC Designer fJ User Modules & 171, JEJT Cap Sensors 3%,

Uzer Modules - I X
ﬂj Uszer Modules

-3 ADCs

LU Amplfiers
-3 Cap Sensors
F_] Digial Lomm
B3 Legacy
[
[
[

+-{_ Misc Digital
+-_1 Protocols
+1-_ Timers

2. ff Cap Sensors X3, £idi CSD, #AJFik#% Place i,

User Modules - 01X
4] User Modules

&3 ADCs

i -1 Amplifiers

EI 1= Cap Sensors

= Place
1__] DlgrtaIC - ]
3
T
(- Misc Di Properties
#-3d Protoco I —
[#-C3 Timers Version List  #
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i F Designer T FCKE I /- ARHUSCE 785 11 g 45 T F e e

CapSense®4# il 4G 7R 7]

- b X

. %arPage mwample m...ject [Chip]* |
o

Pt 0D
Port 011 g
Porl 0 3 3

Poet B 3 >

2CSEM

WWW.Cypress.com

FingerThreshold
Noise Threshald
BaselineUpdate Threshold
Sensors Autoreset
Hysteresis
Debounce
NegativeMNoise Threshold
LowBaselineReset
iDAC Value
Resalution
Scanning Speed
ShieldElectrodeOut
PrechargeSource
Prescaler
PRS Resolution
Autocalibration
Idac Range

User Module

User Module name.
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Ay CSD F A #idk, 4RJ5i%EF: CSD Wizard i,
FAVE A Z 18 5o 5| B FR s MR R

R - |

e

Mext Allowed Placement
Place

Unplace

Rename

Delete

Select Color

Datasheet

C5D Wizard... Ctrl+W, W

X, KiiE CapSense Wizard % 1.

Gkshal Settngs | Sanoes & 1
3 aelbrg s S
Butions 1
Sidais 1

Prochal Shers L}
Hisubaiod Capacdol F M one

Bultan:
Buaoors Senvions Courd

g B B @ a oW
Chic P Assgrevend View | Tabie P Assgred Yien B = i 5 =

|

E=EEE, 8 EEEE
ESEEEHESEEEY

o UUUUHUOUEC

AT SR AR LA L1 47 41 2R3 07
[ % 1 w = P
Pl 3 w T Pl
-
e = =
P[1) 7 aFH w0 5 FHE
Eil=E o=
I"'SI-J g b L - P'Slj
Py O = ] srEs
[Sle] =E5 s ) FE

NITL IS NEIT 1A NEM2NIT N

A0NAAAAANRANN

P = SEES Tpend bot Cheg:
FREPCRACEERT T Uneslabie pins

1 Loihedpin:

LEE

Todsl Semvoge & | Swalches 1 | Shoeses: 1 Radad Skdeix 0
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5. 7 CSD Wizard % 0¥ AL E Global Settings.
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